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This instruction manual describes how to operate the TM20 Termo-Collector.

■ Intended readers
This manual is addressed to those who actually measure temperatures with a TM20 Thermo-
Collector and those who set up a TM20 Thermo-Collector and perform data processing with
a TM20 Thermo-Collector, i.e., operators and engineers.

■ Structure of this manual
This manual is composed of four parts:

● Before Use
Be sure to read this part before using the TM20.  This part explains fundamentals such as the
name and functions of each part of the TM20 and how to input characters.

● Preparing for Measurement
Read this part before measuring a temperature.  This part explains the Thermo-Collector
software and how to set up your TM20.

● Measuring Temperatures
Read this part when measuring temperatures.  This part explains major operations required to
actually measure temperatures.

● Working with Measured Data
Read this part when using and analyzing the data measured by a TM20.  This part explains
how to transfer the measured data to a personal computer and print them.

■ Checking contents of package
When a TM20 Thermo-Collector is delivered, visually check it to ensure that it is not dam-
aged.  Also make sure that the following items have been supplied.  If any of the items are
missing, please contact the dealer from which you purchased the TM20.
Keep this box in case this product needs to be returned to the manufacturer for repair.

Item name Quantity
TM20 Thermo-Collector 1
Floppy disks of Thermo-Collector software installer 3
ANSI AA (IEC LR6) alkaline batteries 2
Dust-proof seals (for sealing screw holes at the rear of TM20 Thermo-Collector) 2
Instruction Manual (this document) 1
Waterproof cover 1
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■ Safety precautions

● About this manual
• Read this manual to gain a thorough understanding of this product before use.
• This manual only describes the functions of the product and makes no warranty of any

kind, including but not limited to, implied warranties of merchantability and suitability for
a particular purpose.

• All rights reserved.  No part of this manual may be reproduced in any form without Yokogawa
Meters & Instruments Corporation’s written permission.

• The contents of this manual are subject to change without notice.
• Should the user find any errors, or unclear or missing information in this manual, contact

the dealer from which you purchased the product or the Marketing Department of Yokogawa
Meters & Instruments.

● Disassembly or modification
• DO NOT disassemble or modify the product.  Only service personnel qualified by Yokogawa

M&C are allowed to disassemble and service the product.

● Handling precautions
• Only parts and consumables specified by Yokogawa Meters & Instruments should be used

in the product.
• Do not store the product in a location where it will be exposed to direct sunlight or high

temperatures, otherwise it may be discolored or deformed.

● Warnings, cautions, and notes
• Follow the safety instructions in this manual when handling a TM20 or its connected acces-

sories.  Yokogawa Meters & Instruments assume no liability for safety if conduct contra-
dicts the safety instructions.

• The  WARNING mark at the rear of the TM20 indicates the precautions that must be
observed when handling the TM20.  Refer to this manual for handling of the TM20.

• Throughout this manual, the following safety conventions are used:

Warning

Indicates hazard where a risk of severe injury and loss of life of the user exists.

Caution

Indicates hazard where a risk of injury of the user or damage to the product or other
equipment exists.

Note

Draws attention to important information about handling of the product or helpful in-
formation about the operations and functions of the product.
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TIP

Provides a tip or information supplementary to the main text.

See Also
Provides one or more references to related topics in this document.

■ Precautions for handling of components
Be sure to observe the following precautions to avoid injury and loss of life of personnel, and
damage to the equipment used.

● Probe

Warning

Do not point the tip of the needle themo probe at a person.  It is very sharp and may
cause injury.

Caution

• Do not touch the stylus (metal part) of a probe that has just been used to measure a
high temperature as it may cause a burn.

• Make sure that the potential differences between probes do not exceed 1 V.
• Do not use a worn or damaged probe, which may be incapable of correct tempera-

ture measurements.
• Before removing a probe from the TM20, pull the probe away from the object mea-

sured.
• When using a probe for liquids, such as a needle probe, insert it into the liquid to be

measured by approximately half the dimension of the probe’s stylus (metal part).
Inserting it too deeply may cause a burn due to heat transfer to the probe grip as
well as cause damage to the probe itself.

• The probe grip and the cable connected from the TM20 must be maintained at a
temperature between –20°C and 50°C.  Unlike the stylus of a probe, these parts have
a low resistance to heat.

• When sending data in real-time, use an ungrounded probe.
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● Batteries

Caution

• Be sure to remove the batteries if the product will not be used for a long period.
Otherwise, the battery liquid may leak and damage the circuitry, resulting in a mal-
function.

• Whenever replacing batteries, be sure to replace both batteries with new ones.  Chang-
ing only one battery may result in the charge current from the new battery flowing to
the old one.

■ Disclaimer of guarantee
• Yokogawa M&C Corporation does not guarantee this product in any way, except as set

forth in the terms and conditions of the certificate.
• Yokogawa M&C Corporation shall not be liable for any consequent or inconsequent dam-

ages to the customer or a third party arising from the use of the product due to any defect in
materials or workmanship beyond the control of Yokogawa Meters & Instruments Corpora-
tion.

■ Figures in this manual
For ease of understanding, figures and illustrations in this manual may not precisely depict
the actual product or software.

■ Care of product
• If there is a need to clean the casing, wipe the surfaces with a wrung wet cloth.
• To remove tough stains, use a cloth dampened with a diluted neutral detergent.  Do not use

any solvent, other detergent, or chemical other than neutral detergents to prevent the prod-
uct from being damaged.

• Keep the connectors and other conductive parts dry to prevent the product from being
damaged.

• When using the product in a place where water may splash the product, use the waterproof
case that comes with the product to prevent the product from becoming dirty and enhance
the product’s water resistance.

■ Maintenance service
When the product needs to be serviced or repaired, contact the dealer from which you pur-
chased the product.

◆ Trademarks
• Microsoft, Windows, Windows 95, Windows 98, Windows NT, and Excel are trademarks

or registered trademarks of Microsoft Corporation, United States.
• Other company and product names appearing in this document are trademarks or registered

trademarks of the respective holders.
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1 Features of This Product

This product is a handy-type thermometer that can measure a temperature and
make a record of it. It has a “collector function” to record the measured tempera-
tures and measurement conditions under the specified tag, and a “logging func-
tion” to automatically measure and record temperatures at given intervals.
The TM20 can simultaneously measure temperatures of channels A and B as well
as being able to measure a potential difference.  The following describes the col-
lector and logging functions.

■ Collector function
The collector function is used when the measured temperature and measurement conditions
are recorded under the specified “tag”.
In the “tag”, the tag name (i.e. “what”), date and time (i.e. “when”), operator name (i.e. “who”),
and alarm (i.e. “judgment on the measured data”) are recorded as the measurement condi-
tions, in addition to the measured temperature.

[Line A ]

Printout of image from a recommended printer

HiAlarm=0080.0 LoAlarm=0060.0

No. Date Data Hi

00001 99/10/08/18:00:00 56.0°C
00002 99/10/08/18:00:10 57.5°C
00003 99/10/08/18:00:25 58.5°C
00004 99/10/08/18:00:35 59.8°C
00005 99/10/08/18:00:45 61.2°C
00006 99/10/08/19:00:00 62.0°C
00007 99/10/08/19:00:11 62.0°C
00008 99/10/08/19:00:26 70.0°C
00009 99/10/08/19:00:34 75.0°C
00010 99/10/08/19:00:47 81.0°C

OK

OK

OK

OK

OK

OK

OK

OK

OK

NG

Lo Person

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

NG

NG

NG

NG

OK

OK

OK

OK

OK

OK

Tag name ("what")

Measurement temperature

Operator name ("who")

Date and time ("when")

Alarm
("measured data judgment")

NG = No Good

It is possible to use maximum 50 tags, and in these 50 tags, a total of 5,000 pieces of tempera-
ture measurement data can be recorded.  However, the more the data is saved with the logging
function, the less number of measurements can be made with the collector function.

[TIP]

At the two-channel simultaneous measurement, 2 data can be recorded in every measurement.  If no
data is recorded at the two-channel simultaneous measurement, 2,500 measurements can be recorded.

Set up the following tag items in advance to use the collector function.
• Tag name
• Input channel
• Alarm
• Operator name

See Also
For more information, refer to the “Preparing for Measurement” part.

1  Features of This Product
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■ Logging function
The logging function is used to automatically measure temperatures at given measurement
intervals and to continue to record the result data.  This function is useful when a temperature
variation within a certain period of time (e.g. temperature variation in a refrigerator being
transported) needs to be recorded.
With this logging function, the temperatures and date (year/month/day) and time will be re-
corded as a “log”.  Unlike the collector function, the logging function does not record the
operator name and alarm (measured data judgment).

[Line B ] Interval=00:00:10

No. Date Data

00001 99/10/09/20:00:00 -10.5°C
00002 99/10/09/20:00:10 -10.5°C
00003 99/10/09/20:00:20 -11.0°C
00004 99/10/09/20:00:30 -10.5°C
00005 99/10/09/20:00:40 -10.5°C
00006 99/10/09/20:00:50 -11.0°C
00007 99/10/09/20:01:00 -10.5°C
00008 99/10/09/20:01:10 -10.5°C
00009 99/10/09/20:01:20 -11.0°C
00010 99/10/09/20:01:30 -10.5°C

Printout of image from a recommended printer

Log name

Date and time

Temperature

Measurement interval

It is possible to use maximum 10 logs, and in these 10 logs, a total of 20,000 pieces of data
can be recorded.  However, the more the data is saved with the collector function, the less
number of measurements can be made with the logging function.

[TIP]

At the two-channel simultaneous measurement, 2 data can be recorded in every measurement.  If no
data is recorded at the two-channel simultaneous measurement, 10,000 measurements can be recorded.

Set up the following items in advance to use the logging function.
• Log name
• Input channel
• Measurement interval
• Measurement period

See Also
For more information, refer to the “Preparing for Measurement” part.

1  Features of This Product
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D RS232C NO.

Made in
Japan

Yokogawa  M&C  Corporation

WARNING

Measuring
temperature  ranges

ESC FUNC

CH

MEMORY

CLEAR

SET

LOGGING POWER

WXYZ

xymbol

YUVPQRS

GHI

ABC DEF

JKL MNO

[4]

Front faceTop face

Bottom face

Back face

[16]

[8]

[9]
[10]

[13]

[11]
[12]

[14]

[15]

[3]

[1]

[2]

[7]

[5]

[6]

2 Names and Functions of Each Part

2  Names and Functions of Each Part

[1] External probe jacks (channels A and B)
Used to plug in the cables of thermocouple type K, J,
E, or T probes or voltage measurement (±100 mV or
±1 mV range) sensors.  (A voltage measurement probe
has a U-shaped omega connector.)

[2] Non-contact thermo probe jack (chan-
nel D)
Used to connect a non-contact thermo probe.

[3] RS-232C communication terminal
Used to output data from this instrument to a per-
sonal computer or printer.

[4] Display (LCD)
Displays Thermo-Collector conditions, various setup

information, measurement temperature, etc.

[5] [CH] key
Used to switch over the input channel between chan-
nels A, B, and D.  Channel D is for a non-contact
thermo probe.

[6] [ESC] key
Used to cancel the previous operation and return to
the previous screen.

[7] [Memory] key
Used to commence a temperature measurement with
either the collector function or the logging function.

[8] [▼] [▲] key
Used to select an appropriate tag, log, or function.

[9] [LOGGING] key
Used to switch between the collector and logging
functions.  Also used to modify alphanumeric char-
acters from uppercase to lowercase.

[10] [POWER] key
Used to turn the power supply on and off.

[11] [Set] key
Used to make the setup contents valid for operation.

[12] [Func] key
Used to set up the selected function.
Also used to delete the measured data.

[13] [1],...,[9], and [0] keys
Used to enter alphabets and numbers.
The [0] key is also used for switching the unit of tem-
perature display.  If, for example, this [0] key is
pressed in the Home screen, the unit is switched to
“�F”. Another pressing of the same key will restore
the unit to “�C”.

[14] [<] and [>] keys
Used to retrieve the logged tag data or log data, or to
select the character input position.

[15] Battery compartment
Accommodates two ANSI  AA (IEC LR6) alkaline
batteries.

[16] Name plate
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3 Setting the Battery

Two ANSI AA (IEC LR6) alkaline batteries are included with this instrument.

1. Open the battery compartment cover at the back of the main unit.

See Also
For the position of the battery compartment, refer to Chapter 2, “Names and Functions of Each Part”.

2. Observing the correct polarity, install the two ANSI AA (IEC LR6) alkaline batteries in
the battery compartment.

Caution

Observe the correct polarity when installing the batteries in the battery compartment.
The main unit may be damaged if the batteries are installed incorrectly.

3. Close the battery compartment cover.

-End of procedure-

Caution

Remove old batteries from the compartment.  Battery liquid leakage may cause the
main unit to malfunction or may damage it. A “BatteryEmpty” message will appear on
the LCD shortly before the battery life expires.  When this message appears, replace
the batteries.

Note
• Whenever replacing batteries, be sure to replace both batteries with new ones.  Changing only one

battery may result in the charge current from the new battery flowing to the old one.

• If temperature suddenly change, condensation may occur.  Set the batteries after acclimatizing the
batteries and TM20 to the ambient temperature.

3  Setting the Battery
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4 Turn ON/OFF of the Power Supply

■ Turn the power supply to ON

Press the [POWER] key.
The time display screen appears on the LCD.

19:13:15

– – – – – – – –
The power of the main unit is turned on.

■ Turn the power supply to OFF

Hold down the [POWER] key for about three seconds.
The power to the main unit will be shut down after a short beep has been sounded.

4  Turn ON/OFF of the Power Supply
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5 Screen (LCD) Displays

12:30:00

0 0 2 8 . 5 � C

[9]

[6]
[5]

[8]
[7]

[2]

[3]

[4]

[1]

[10]

[11]

[12]

[1] Indicates that the chime function is being set.

[2] Indicates whether the current mode is the collector mode or logging mode.  If LOG is
displayed, the current mode is the logging mode.  If it is not displayed, the current
mode is the collector mode.

[3] Indicates the input channels currently used for measurement.
[4] Indicates that the measurement data is being logged into the instrument.

The “ ” mark indicates the status that the “Real-time data transmission” can be
used.

[5] Indicates that the alarm is set.
[6] Indicates that either the [<] or [>] key can be used.
[7] Indicates that either the key lock or FUNC lock is set.  If the key lock function is

on, all the keys are disabled.  In the FUNC lock state, only the temperature mea-
surement keys can be used.

See Also
For information about canceling the lock state, refer to Chapter 7, “Other Useful Functions” in the
“Measuring Temperatures” part.

[8] Indicates that the battery is almost used up.  Replace the battery as soon as
possible after this symbol is displayed.

[9] Indicates that the instrument is set so that the power to the main unit will be
automatically turned off if no operation is made in a predetermined period of
time.

[10] Indicates that either the [▲] or [▼] key can be used.
[11] Indicates that the timer function is on and the instrument is in the wait state.
[12] A tag name, log name, and temperature will be displayed.

[TIP]

If this instrument is used in a location where the ambient temperature is low, the characters may be
displayed slowly.  Note that this does not indicate the main unit being at a malfunction.

5  Screen (LCD) Displays
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6 How to Input Characters
This section explains the character input procedure.  Alphabets and numbers can
be entered.
The procedure used to input characters into Thermo-Collector is similar to the
method used to enter characters in a cellular phone.

■ Entering characters
Use the 0  to ➈  keys to enter characters.  These keys are also used to enter alphabets.
For example, the ➁  key can be used to enter “A” to “C”, and “2”. To enter “C”, press the 2

key three times.
To enter “2”, press the ➁  key four times.

Key

Mode

1

Alphanumeric input mode

1

A B C 2
ABC

2

DEF

GHI

JKL

MNO

PQRS

TUV

WXYZ

Symbol

3

4

5

6

7

8

9

0

D E F 3

G H I 4

J K L 5

M N O 6

P Q R S 7

9

%

T U V 8

W X Y Z

0 ! # $ )& ( =+ -

■ Entering lowercase characters

1. Enter a character to be made small.

A

[ N e w T a g ]

2. Position the cursor on the character and press the [LOGGING] key.
This character is made small.

a

[ N e w T a g ]

- End of procedure

6  How to Input Characters
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1   Overview of Preparation for Measurement
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Before measuring temperatures, set the tag names, etc., on the main unit.
There are two methods for making the settings.  One is for the main unit and the
other is for a personal computer.  For efficiency, use a personal computer to set
many items.

    Setting up the main unit
    • Setting the date and time
    • Setting the name of the main unit

    Download: 
   • Settings.
   • Name of the operator.

    Measure the temperature

Setting up TM20 via TM20’s faceplateSetting up TM20 from PC

: Setup to be performed in this part

Make settings (using a tag/log table) for: 
• Collector function

such as the tag names, input 
channel(s) used, alarms, name 
of the operator, and comments.  

• Logging function
such as the log name, input 
channel(s) used, measurement 
interval, and measurement 
period.

Make settings for: 
• Collector function

such as the tag names, input 
channel(s) used, alarms, name 
of the operator, and comments.  

• Logging function
such as the log name, input 
channel(s) used, measurement 
interval, and measurement 
period.

1 Overview of Preparation for Measurement
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2  Setting Up the Main Unit

99

P
rep

arin
g

 fo
r

M
easu

rem
en

t

2 Setting Up the Main Unit

2.1 Setting the date and time

Home screen

18:54:27

22225.9°C

[TIP]

This screen which displays the current time is
referred to as the “Home” screen.  All the func-
tions in the main unit are accessed from this
screen.

1. Press the [FUNC], [6], and [1] keys, in
order.
The “ClockSet” screen appears on the LCD.

F61

C l o ck S e t

2. Press the [SET] key.
A screen for setting the date appears.

Date

9 8 / 1 1 / 1 1

3. Enter the date.
Use the [0] to [9] keys for input. The [<] or [>] key
moves the cursor.

4. Press the [SET] key.
A screen for setting the time appears.

Time

1 8 : 5 6 : 1 4

5. Enter the time.

6. Press the [SET] key.
The specified time is set.

F61

C l o ck S e t
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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2.2 Setting the name of the
main unit

If more than one Thermo-Collector is used
at a time, a individual name must be set for
each.

[TIP]

Make this setting as necessary.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [9], and [7] keys, in
order.
The “Name” screen appears.

F97

Name

2. Press the [SET] key.

DevName

Name00---

3. Enter the name of the instrument (Ex-
ample: NO1).

DevNamee

NO1

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters” in the
“Before Use” part.

4. Press the [SET] key.
The instrument name is set.
The “Name” screen is restored.

F97

Name
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3 Setting Up with the Personal Computer

3.1 Setting up the “Thermo-Collector” software

The setup operation required for the main unit can be performed on a personal computer.
The “Thermo-Collector” software must be used to do this.  This section explains the proce-
dure used to set up the “Thermo-Collector” software on the personal computer.

Connecting the personal computer and the main unit
↓

Installing the “Thermo-Collector” software on the personal computer
↓

Confirming the communication environment (on the personal computer)
↓

Confirming the communication environment (on the main unit)

■ Connecting the personal computer and the main unit
Purchase an RS-232C cable (Model name: 910 09, round DIN 8-pin to D-sub 25-pin type).
Follow the procedure below to connect the main unit to the personal computer.

1. Turn off the power to both the personal computer and main unit.

2. Connect the personal computer and the main unit as shown in the following diagram.

D

Bottom of the
main unit (8-pin)

Main unit Personal computer

Plug this cable into the connector so that the
“    ” mark on the grip faces downward.

Serial port of the personal
computer (with 25-pin connector)

Dedicated cable (Model name: 910 09)

1 4
2 2
3 5
4 3
7 7
8 7
5, 6 (N.C.)

Connection between connector pins
(Round DIN 8-pin to D-sub 25-pin)

ESC FUNC

CH

MEMORY

CLEAR

SET

LOGGING POWER

WXYZ

Symbol

YUVPQRS

GHI

ABC DEF

JKL MNO

3. First turn on the power to the main unit, then turn on the power to the personal com-
puter.

-End of procedure-
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■ Installing the “Thermo-Collector” software
Install the “Thermo-Collector” software on the personal computer.  The three floppy diskettes
that come with the main unit are required for this installation.

1. Place a floppy diskette (Setup Disk #1) in the floppy disk drive of the personal com-
puter.

2. Double-click on the “My Computer” icon.
The “My Computer” folder is displayed.

3. Double-click on the floppy disk drive icon (A:drive in the case of a DOS/V machine).

4. Double-click on “Setup”.
The Setup is initiated and a screen prompting the insertion of the second floppy diskette (Setup Disk #2) appears.
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5. After inserting the second floppy diskette (Setup Disk #2), click on the [OK] button.
Precautions to be observed prior to installation appears.

6. Click on the [OK] button.
The installer of the application program is initiated and the “Thermo Collector Setup” screen is displayed.

7. Click on the [Start Setup] button.
A screen prompting the insertion of the third floppy diskette (Setup Disk #3) appears.

8. After inserting the third floppy diskette (Setup Disk #3), click on the [OK] button.

[TIP]

Do as follows to change the application install destination.
1.Click on the [Change Directory] button.
2.Select a installation destination folder.
3.Click on the [OK] button.

After installation has been completed, the following confirmation window is displayed.

[TIP]

If the another window is displayed, set the new group name and click [Continue] button.  (Select the
name from “group list” when you already have the name you want to use, and click [Continue] button.

9. Click on the [OK] button.

-End of procedure-
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■ Confirming the communication environment (on the personal computer)
Confirm the settings related to the communication environment on the personal computer.

1. Select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.

2. Select “Properties” from the “Comm” menu.
The “Properties” window is displayed.

3. Confirm that the settings are exactly as shown in the above figure.
If any of the settings are different, set them to the values given below.

Setup item Setting value
CommPort 1

Baud Rate 9600

Parity None

Data Bits 8

Stop Bits 2

[TIP]

The communication port setting values vary, depending on the type of personal computer.  For more
information, refer to the manual supplied with your personal computer.

-End of procedure-
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■ Confirming the communication
environment (on the main unit)
Confirm the settings related to communica-
tion environment on the main unit.  Con-
firm that the settings are exactly as shown
in the following table.
If any of the settings are different, set them
to the values given below.

Setup item Setting value (Factory Settings)
Baud Rate 9600
Parity None

Data Length 8bit

Stop Bits 2bit
Flow Control None

Home screen

18:54:27

22225.9°C
1. Press the [FUNC], [5], and [1] keys, in

order.
A screen for setting the communication environment
appears.

F51

Comm Set
2. Press the [SET] key.

A screen for setting the baud rate appears.  The dis-
played baud rate is 9600 bps, which is factory set-
ting.

Baudrate

9600
3. Press the [SET] key.

A screen for setting the parity appears.  The displayed
parity is None, which is factory setting.

Parity

None

4. Press the [SET] key.
A screen for setting the data length appears.  Con-
firm that the displayed data length is as shown in the
following figure.

Data Len

8 b i t
5. Press the [SET] key.

A screen for setting the number of stop bits appears.
The displayed number of stop bits is 2 bits, which is
factory setting.

Stop Bit

2 b i t
6. Press the [SET] key.

A screen for setting the flow control method appears.
The displayed flow control method is None, which is
factory setting.

Flow

None
7. Press the [SET] key.

Returns to the communication environment setup screen.

F51

Comm Set
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3.2 Basic operation of Thermo-Collector software

This section explains the basic operation of the supplied software.

■ Initiating Thermo-Collector software

1. Select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.
At first, the model (of the Thermo-Collector) selection screen is displayed.

2. Click the text-box to select the model TM20.

3. Click on the [OK] button.
After the main screen of the software is displayed, the “Setup Tags/Logs - New” screen is displayed.
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■ Terminating Thermo-Collector software

Select “Exit” from the “File” menu.

■ Saving the setup data in a file

1. Select “Save As” in the “Setup Tags/Logs” menu accessed from the “File” menu.
The “Save As” window is displayed.

2. Enter a file name in the “File name” field, then click on the [Save] button.
The setup data is saved.

-End of procedure-
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■ Loading a file containing the setup data

1. Select “Open” in the “Setup Tags/Logs” menu accessed from the “File” menu.
The “Open” window is displayed.

2. Select a file to be loaded, then click on the [Open] button.
The specified file containing the setup data is loaded, and the tag and log setup data in the file is displayed.

-End of procedure-
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■ Saving the measurement operator name data
The operator data is saved in a file different from that in which the tag and log data is stored.

1. Select “Save As” in the “Setup Persons” menu accessed from the “File” menu.
The “Save as” window is displayed.

2. Enter a file name in the “File name” field, then click on the [Save] button.
The measurement operator name data being set is saved.

-End of procedure-
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■ Loading the measurement operator name file

1. Select “Open” in the “Setup Persons” menu accessed from the “File” menu.
The “Open” window is displayed.

2. Select a file to be loaded, then click on the [Open] button.
The measurement operator name file is loaded, and a list of operator names is displayed.

-End of procedure-
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■ Other functions (Menu functions)

“Setup Tags/Logs” submenu

Opens a file in which tags and logs have
been stored.

New

Open

Save

Save As

Send

Print

Overwrites a file in which tags and logs
have been set.

Saves a file in which tags and logs have
been set under a new file name.

Transmits the tag and log setup data to
the main unit.

Outputs the tag and log setup data for
the printer.

Creates a new setup file of tags and logs.

“Setup Persons” submenu

Outputs the operator name data for the printer.

Creates a new file for setting up operator names.
New

Open

Save

Save As

Close

Send

Print

Opens a file in which operator names have been stored.

Overwrites a file in which operator names have been set.

Saves a file in which operator names have been
set under a new file name

Closes the operator name setup screen.

Transmits the operator name data file currently
opened to the main unit.

“Setup Comment” submenu

Outputs the comment data for the printer.

Creates a new file for setting up comment.
New

Open

Save

Save As

Close

Send

Print

Opens a file in which comment have been stored.

Overwrites a file in which comment have been set.

Saves a file in which comment have been set 
under a new file name

Closes the comment setup screen.

Transmits the comment data file currently
opened to the main unit.
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“Measured Datas” submenu

Save As
Saves the measurement data in a text format.

Close
Closes the measurement data file.

Transfer
Transfers the measurement data file to Excel.

Print
Outputs the measurement data to the printer.

“Tag/Log Table” submenu
New
Opens a new blank tag/log table. 

Open
Opens an existing tag/log table.  

Save
Saves the changes to the open tag/log table.

Select Reference Table
Selects the reference tag/log table.  Based on 
this reference table, abbreviated names will be 
replaced with the respective full names. 

Clear Reference Table
Clears the selection of reference tag/log table.

Forward to Tag/Log Setup File
Forwards the settings in the open tag/log table to 
the setup file.

Save As
Saves the open tag/log table under a new 
filename.

“Person Table” submenu
New
Opens a new blank person table (a list of 
operators). 

Open
Opens an existing person table.

Save
Saves the changes to the open person table.

Select Reference Table
Selects a person table.  Based on this person 
table, abbreviated person names will be 
replaced with the respective full names.

Clear Reference Table
Clears the selection of reference person table.

Forward to Person Setup File
Forwards the settings in the open person table to 
the setup file. 

Save As
Saves the open person table under a new 
filename.
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“Comment Table” submenu

New
Opens a new blank comment table.

Open
Opens an existing comment table. 

Save
Saves the changes to the open comment table.

Select Reference Table
Selects a comment table.  Based on this 
comment table, abbreviated comment names will 
be replaced with the respective full names. 

Clear Reference Table
Clears the selection of reference comment table. 

Forward to Comment Setup File
Forwards the settings in the open comment table 
to the setup file. 

Save As
Saves the open comment table under a new 
filename. 

“Voltage Range Settings” submenu

New
Opens a new blank voltage setting file. 

Open
Opens an existing voltage setting file.

Save
Saves the changes to the open voltage setting file. 

Send
Sends (downloads) the settings in the open voltage 
setting file to the TM20.

Receive
Receives (uploads) the voltage measurement 
settings inside the TM20. 

Save As
Saves the open voltage setting file under a new 
filename.

“Comm” menu
Properties
Set the conditions required to communicate with the personal
computer.  Below are the setup items
 • Communication port
 • Baud rate
 • Parity
 • Data bits
 • Stop bits

Receive
Receives from the main unit the measured temperature data and
other data set with the main unit.
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“Edit” menu

Select All
Sets all the data on the currently selected box to the selected
condition.

Copy
Copies the currently selected data to the pasteboard.

Paste
Copies the data recorded in the pasteboard to the selected
location on the screen.

Delete
Deletes the currently selected data.

Cut
Moves the currently selected data to the pasteboard.

Column and Row (usable only in tag/log table, person table 
and comment table.)
Add / insert / delete column or row, and modify column’s name.

Sort (usable only in tag/log table, person table and comment 
table.)
Performs data sorting in the columns of “Abbr. Name” and 
“Full name”.

Mark (usable only in tag/log table, person table and comment 
table.)
Selects “Select All” or “Cancel All” of the selected settings 
high lighted in yellow for transmitting to the setting file etc.

[TIP]

Measurement data received from the main unit cannot be edited using the “Edit” menu functions.

“Display” menu
Tool Bar
Switches on and off the toolbar display (button icon allowing
one-touch operation).

Status Bar
Switches on and off the status bar display (a region in which the
date and time are displayed).

“Help” menu

About Thermo-Collector...
Displays the version information of the Thermo-Collector
software.

Model
Displays model code of the Thermo-Collector in use.
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■ Other functions (Tool icons functions)
For efficiency, single-click on any of the tool icons to instantly execute the assigned function.

Creates a new setup file of tags and logs.
This function is the same as “New” in the
“Setup Tags/Logs” submenu of the “File”
menu.

Loads a file of stored tags and logs.  This
function is the same as “Open” in the “Setup
Tags/Logs” submenu of the “File” menu.

Saves the tag and log setup data file so it
overwrites the existing file.  This function
is the same as “Save” in the “Setup Tags/
Logs” submenu of the “File” menu.

Transmits the tag and log setup data cur-
rently selected to the main unit.  This func-
tion is the same as “Send” in the “Setup
Tags/Logs” submenu of the “File” menu.

Creates a new file for setting operator
names.  This function is the same as “New”
in the “Setup Persons” submenu of the
“File” menu.

Loads the operator name file that has been
saved.  This function is the same as “Open”
in the “Setup Persons” submenu of the
“File” menu.

Saves the operator name file so it overwrites
the existing file.  This function is the same
as “Save” in the “Setup Persons” submenu
of the “File” menu.

Transmits the operator name data currently
displayed on the screen to the main unit.
This function is the same as “Send” in the
“Setup Persons” submenu of the “File”
menu.

Saves the measured data in a text format file.
This function is the same as “Save As” or
“Save” in the “Measured Datas” submenu
of the “File” menu.

Creates a new file for setting comments.
This function is the same as “New” in the
“Setup Comments” submenu of the “File”
menu.

Loads the comment file that has been saved.
This function is the same as “Open” in the
“Setup Comments” submenu of the “File”
menu.

Save the comment file so it overwrites the
existing file.  This function is the same as
“Save” in the “Setup Comments” submenu
of the “File” menu.

Transmits the comment data currently dis-
played on the screen to the main unit.  This
function is the same as “Send” in the “Setup
Comments” submenu of the “File” menu.

Loads the measured data file that has been
saved.  This function is the same as “Open”
in the “ Measured Datas” submenu in the
“File” menu.

Transfers the measurement data which is
going to the personal computer to Microsoft
Excel.  This function is the same as “Trans-
fer” in the “Measured Datas” submenu of
the “File” menu.

Outputs the measurement data received in
association with the specified tag and log
to the printer.  This function is the same as
“Print” in the “Measured Datas” submenu
of the “Comm” menu.

Forwards the settings in the open tag/log
table to the setup file.  This function is the
same as “Forward to Tag/Log Setup File”
in the “Tag/Log Table” submenu in the
“File” menu.

Forwards the settings in the open person
table to the person setup file.  This function
is the same as “Forward to Person Setup
File” in the “Person Table” submenu in the
“File” menu.

Forwards the settings in the open comment
table to the comment setup file.  This func-
tion is the same as “Forward to Comment
Setup File” in the “Comment Table”
submenu in the “File” menu.

Receives the data from the main unit.  This
function is the same as “Receive” in the
“Comm” menu.

Moves the currently selected data to the
pasteboard.  This function is the same as
“Cut” in the “Edit” menu.

Copies the currently selected data to the
pasteboard.  This function is the same as
“Copy” in the “Edit” menu.

Copies the data recorded in the pasteboard
to the currently selected location on the
screen.  This function is the same as “Paste”
in the “Edit” menu.
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3.3 Files created on a computer for settings of TM20

Tag/log table i Setup file 1

Setup file 2

Select Reference Table

Many setup files can 
be created from the same 
tag/log table.  

Files that contain settings to be written 
(downloaded) to a TM20.  

Select a tag/log table. Based on this tag/log table, 
abbreviated names will be replaced with the respective full names.  

Tag/log tables, person tables, and comment tables.
Used previously to make a variety of measurement settings as lists of the respective settings.
By simply choosing an entry from each table, you can create a setup file for your TM20.  

Setup files, person settings, and comment setting.
Files containing settings to be written (downloaded) to a TM20.  

Tables of settings for creating setup files.
Each table contains settings required for measurement.  

Abbreviated tag and log names can be replaced with the respective full names.

Person table j Person setting 1

Person setting 2

Person setting 3

Comment table k Comment setting 1

Comment setting 2

Select Reference Table

Abbreviated person names can be replaced with the respective full names.  

Select Reference Table

Abbreviated comment names can be replaced with the respective full names.  
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3.4 Setups required to use collector function (setting tag names,
alarms, name of person, and comment, and selecting input
channel(s))

To use the collector function, you need to set the tags in advance.  A convenient way to do so
is to create a table of tags and logs, namely, a tag/log table.  Once you create a tag/log table
and set it to the reference table, Thermo-Collector automatically replaces abbreviated tag
names* with more descriptive full names** when receiving the measured data from a TM20.

* Abbreviated names are 8-digit names that can be displayed on the TM20 screen.

** Full names can be displayed on the PC screen without any limitation in length.

■ Setup contents

● Tag name
Put a title for each tag.

● Input channel
Thermo-Collector has multiple input channels and probes for measuring temperatures of
substances in a vapor, solid, or liquid phase.  Since the probe to be used depends on the
measuring object, it is necessary to set the available input channel on a tag in advance.
The following table shows the probe types and their corresponding input channels.

Probe type Input channel

Thermocouple types K, J, E, and T
±100 mV or ±1 V voltage output sensor (See TIP below.) A, B

[TIP]

To plug a voltage output sensor into channel A or B, use a U-shaped omega connector.

● Alarm
Set a limit temperature at which the alarm sounds.
• ON/OFF  of the upper-limit alarm and upper-limit temperature

Make the following settings to sound an alarm when the temperature rises above a preset limit.
The upper-limit temperature cannot be set if the alarm function for the upper limit is set to OFF.

Temperature

Setting the upper-limit alarm to ON and the upper-limit temperature to 70°C

70°C

: Range in which the alarm sounds.
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• ON/OFF of the lower-limit alarm and lower-limit temperature
Make the following settings to sound an alarm if the temperature falls below a preset limit.
The lower-limit temperature cannot be set if the alarm function for the lower limit is set to OFF.

Temperature

Setting the lower-limit alarm to ON and the lower-limit temperature to 50°C

50°C

: Range in which the alarm sounds

• Inverse alarm function ON/OFF
The settings of the alarm function can be inverted.
Specifically, if this inverse alarm functions is set to ON, an alarm will sound if the temperature falls
below the upper limit or if the temperature rises above the lower limit.

Temperature

Upper-limit alarm       70°C
Lower-limit alarm       50°C

70°C

50°C

Upper-limit alarm       70°C
Lower-limit alarm       50°C

Temperature

70°C

50°C

: Range in which the alarm sounds

If “OFF” If “ON”

[TIP]

The alarm can also be set to turn off if the temperature exceeds the upper limit, or it can be set to turn
on if the temperature falls between the upper and lower limits.

● Operator name
Set the name of the operator.

See Also
For how to set the operator name, refer to “■  Registering the measurement operator name”.
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■ Setting tags

● Make settings using a tag/log table
A variety of tag settings can be set beforehand in a table, and from the table, you can select
settings to be downloaded to a TM20 as appropriate.

1. Run Thermo-Collector.
After the Thermo-Collector main window opens, a document window entitled “Setup Tag/Logs - New” opens in it.

2. From the File menu, choose Tag/Log Table then New to open the Tag/Log Table window
(a document window).
Tag/Log Table window

3. Enter the tag names in the Abbr. Name column with a maximum of eight alphanumeric
characters (for example, Burger).

4. In the Full Name column, enter more descriptive tag names.
There is no limitation in length with full names.  If you select this table as the reference tag/log table, Thermo-
Collector will replace the abbreviated names with the corresponding full names based on this table when receiving
measured data from a TM20.
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5. Double-click in the “Channel” column.
The specified tag name is set and the pull-down menu appears.

6. Select either A, B, D, or AB.
The specified channel is set.

7. Click in the “Upper Limit” column
The cursor moves to a cell for the “Upper Limit”.

8. Enter the “Upper Limit” with numeric characters (Example: 150.0).

[TIP]

Enter a value that does not exceed “Upper Limit” of the probe used for actual measurement.  The
“Upper Limit” that can be measured varies according to the probe used for measurement.

The specified upper-limit temperature has been set.
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9. Double-click in the “Hi Alarm” column.
The pull-down menu appears.

10. Select either ON or OFF.

11. Click in the “Lower Limit” column.
The upper-limit alarm ON/OFF setting is made and the cursor moves to the “Lower Limit” column.

12. Enter the “Lower Limit” with numeric characters (Example: 135.0).

[TIP]

Enter a value that does not fall below the “Lower Limit” of the probe used for the actual measurement.
The “Lower Limit” that can be measured varies according to the probe used for the measurement.

The specified lower-limit temperature has been set.

13. Double-click in the “Lo Alarm” column.
The pull-down menu appears.
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14. Select either ON or OFF.
The lower-limit alarm ON/OFF setting is made.

15. Click in the “Turn Alarm” column.
The pull-down menu appears.

16. Select either ON or OFF.
The alarm condition is set.

You can insert and add rows by either of the following ways:

• Using a shortcut menu that opens by a right-click

• Using keystrokes of CTRL+I and CTRL+R

Repeat steps 3-16 to set as many tags as necessary.

17. Save the table.
From the “File” menu, choose “Tag/Log Table” then “Save As” to save the table.

-End of procedure-
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● Creating a tag/log setup file to be downloaded to a TM20
From a tag/log table, select settings to create a tag/log setup file to be downloaded to a TM20.

1. In the Tag/Log Table window, double-click to select the cell No. of a tag whose setting is
to be downloaded to the TM20.
The row of the selected tag setting then appears highlighted in yellow.  To clear the selection, double-click it again.

2. From the File menu, choose Setup Tags/Logs then New to open the Setup Tags/Logs
window of a blank setup file.

3. Click .  The selected tag setting is then copied to the Setup Tags/Logs window.

Tag/log table Setup file

4. Select the measurement range.
The measurement range is selected as “K” (meaning thermocouple type K) by default.  To set to a different range,
click “Channel A” or “Channel B” box, as appropriate, in the Setup Tags/Logs window and choose the desired range
from “K”, “J”, “E”, “T”, “1V”, and “100mV”.

5. Save the setup file.
The setup file can be saved by choosing “Setup Tags/Logs” then “Save As” from the “File” menu.

[TIP]

A row of data in which the Abbr. Name column is left blank cannot be downloaded to a TM20.  Make
sure the abbreviated names are set for all tags.

-End of procedure-
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● Selecting the reference tag/log table which should be used to replace
abbreviated names with full names
Instead of abbreviated tag and log names, the longer, more descriptive full names set in a
specified table can be stored along with measured data to an Excel worksheet file.  When
receiving a batch of measured data from a TM20, Thermo-Collector searches through the
Abbr. Name column in the specified reference file of tag/log table for names that match the
tag or log names of the received data.  If a matching name is found, Thermo-Collector fetches
the full name corresponding to the abbreviated name from the reference table, and stores the
full name in the Excel worksheet file in place of the abbreviated name.

1. From the File menu, choose Tag/Log Table then Select Reference Table.
Then, select the reference table in the dialog box that appears.

2. Click Yes to confirm the selection.

Once the reference table is selected, its filename is displayed in the lower-left of the window and the aforementioned
automatic name replacement will take place.

[TIP]

Of course, you can directly set entries in a setup file instead of copying settings from a tag/log table.

Next, proceed to operator name setting.

- End of procedure -
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■ Setting operator names

● Make settings with a person table
A person table is a list of the set operator names. It is possible at any time to select whichever
settings from a person table you want.

1. From the File menu, choose Person Table, then New.
A document window for setting operator names, entitled “Person Table - New” as shown below, then opens.

Person Table window

2. In the Abbr. Name column, enter operator names of up to eight characters.
Abbreviated names stand for shortened operator names of up to 8 alphanumeric characters that can be displayed on
the TM20 screen.

3. In the Full Name column, enter the longer, more descriptive names of the operator.
Full names have no limitation in length.  If you select this table as the reference person table, Thermo-Collector will
replace the abbreviated names with the corresponding full names based on this table when receiving measured data
from a TM20.

4. Add and insert rows as necessary.
You can insert and add rows by either of the following ways:

• Using a shortcut menu that opens by a right-click

• Using keystrokes of CTRL+I and CTRL+R

5. Click the Abbr. name cell of the next row and set.
Enter the abbreviated and full names again.

6. Save the table.
From the File menu, choose Person Table then Save As to save the table.

- End of procedure -
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● Creating a person setup file to be downloaded to a TM20
From a person table, select settings to create a person setup file to be downloaded to a TM20.

1. In the Person Table window, double-click to select the cell No. of an entry which is to be
downloaded to the TM20.
The row of the selected entry then appears highlighted in yellow.  To clear the selection, double-click it again.

2. From the File menu, choose Setup Persons then New to open the Setup Persons win-
dow of a blank setup file.

3. Click .  The selected operator name entry is then copied to the Setup Persons

window.

- End of procedure -

● Selecting the reference person table which should be used to replace
abbreviated names with full names

1. From the File menu, choose Person Table then Select Reference Table.
Then, select the reference table in the dialog box that appears.

When receiving a batch of measured data from a TM20, Thermo-Collector searches through the Abbr. Name column
in the specified reference file of person table for names that match the operator names of the received data.  If a
matching name is found, Thermo-Collector fetches the full name corresponding to the abbreviated name from the
reference table, and stores the full name in the Excel worksheet file in place of the abbreviated name.

Once the reference table is selected, its filename is displayed in the lower-middle part of the window and the afore-
mentioned automatic name replacement will take place.

[TIP]

• The person table can be saved by choosing Person Table then Save As from the File menu.

• Of course, you can directly set entries in a setup file instead of copying settings from a person table.
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■ Setting comments
Comments for recording in a TM20 can be set.  Up to 32 previously set comments can be
stored in the memory of a TM20 together with each measured value.  For example, setting a
comment describing the action taken when the result of measurement is no good, such as
“Re-measure” or “Discard,” records the action that was performed consequently.

● Setting comments in a new comment table

1. From the File menu, choose Comment Table, then New.
A document window titled “Comment Table,” as shown below, then opens.

Comment Table window

2. Enter comments.
Abbreviated comments can be up to eight characters long, whereas there is no limit to the number of characters for
full names.  Set a descriptive comment for each full name.  When uploading measured data from a TM20 to the PC,
the abbreviated comments are replaced with the corresponding full names.

Rows can be added and inserted using commands on the shortcut menu which opens by a right-click, or by using the
keystrokes CTRL+R and CTRL+I.

3. Save the comment table.
To save the table of comments you set, click “File” and choose “Comment Table” then “Save As”.

- End of procedure -
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● Creating a comment setting file
Select a comment from a comment table and write (download) it to the connected TM20.

1. In the Comment Table window, double-click to select the comment to be set in the
TM20.
The row of the selected comment setting then appears highlighted in yellow.  To clear the selection, double-click it
again.

2. Then, click .  The selected comment is then copied to the Setup Comments win-

dow.

- End of procedure -

● Selecting a reference table for replacing abbreviated comments with full
comments

1. From the File menu, choose Comment Table then Select Reference Table.
Selecting the reference comment table enables the following automatic replacement.

When importing a batch of measured data from the TM20 into an Excel worksheet file, Thermo-Collector searches
through the Abbr. Comment column in the specified comment list file for those that match the comments in the
received data.  If it is found, Thermo-Collector fetches the full comment corresponding to the abbreviated comment
from the list, and stores that full comment in the Excel worksheet file instead of the abbreviated comment.

Once the reference comment list file is selected, its filename is displayed in the lower left of the window.

- End of procedure -

● Downloading comments to TM20

To load the comments which have been set, click .
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3.5 Setups required to use the logging function
(setting the log name, input channel, measurement interval,
and measurement period)

Settings relating to the logging function must be made here.

A convenient way to do so is to create a table of tags and logs, namely, a tag/log table.  Once
you create a tag/log table and set it to the reference table, Thermo-Collector automatically
replaces abbreviated tag names* with more descriptive full names** when receiving the
measured data from a TM20.

* Abbreviated names are 8-digit names that can be displayed on the TM20 screen.

** Full names can be displayed on the PC screen without any limitation in length.

■ Setup contents

● Log name
Put a title to each log.  A log name can consist of a maximum of eight alphanumeric charac-
ters.

● Input channel
Thermo-Collector has multiple input channels and probes for measuring temperatures of
substances in a vapor, solid, or liquid phase.  Since the probe to be used depends on the
measuring object, it is necessary to set the available input channel on a tag in advance.
The following table shows the probe types and their corresponding input channels.

Probe type Input channel

Thermocouple types K, J, E, and T
±100 mV or ±1 V voltage output sensor (See TIP below.) A, B

[TIP]

To plug a voltage output sensor into channel A or B, use a U-shaped omega connector.

● Measurement interval
Set an interval at which the temperature is periodically measured.  The interval can be set to
between 1 second to 24 hours.

● Measurement period
Set a period through which the temperature is measured continuously.  The period can be
set to between 1 second to 999 days.
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■ Setting logs

● Make settings using a tag/log table
A variety of tag settings can be set beforehand in a table, and from the table, you can select
settings to be downloaded to a TM20 as appropriate.

1. Run Thermo-Collector.
After the Thermo-Collector main window opens, a document window entitled “Setup Tag/Logs - New” opens in it.

2. From the File menu, choose Tag/Log Table then New to open the Tag/Log Table window
(a document window).
Tag/Log Table window

3. Enter the log names in the Abbr. Name column with a maximum of eight alphanumeric
characters (for example, Convey).

4. In the Full Name column, enter more descriptive tag names.
There is no limitation in length with full names.  If you select this table as the reference tag/log table, Thermo-
Collector will replace the abbreviated names with the corresponding full names based on this table when receiving
measured data from a TM20.

5. Double-click in the “Channel” column.
The specified log name is set and the pull-down menu appears.

6. Select either A, B, D, or AB.
The specified channel is set.

7. Click in the “Measuring interval” column.
The cursor moves to a cell for the measurement interval.

8. Enter the measurement interval with numeric characters and colons “:”  (Example:
00:10:00).
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[TIP]

Use numeric characters and colons to enter a measurement interval.  The input range is: hh < 25, mm
< 60, and ss < 60, where “hh” denotes hours, “mm” denotes minutes, and “ss” denotes seconds.
All the interval data must be eight characters or less (i.e. “hh:mm:ss”. h, m, and s are optional numeric
characters).

The specified measurement interval has been set.

9. Click in the “Measuring period” column.

Enter the measurement period with numeric characters, a backslash, and colons
(Example: 003/20:30:00).

[TIP]

Use numeric characters, a backslash, and colons to enter a measurement period.  The input range is:
ddd < 1000, hh < 24, mm < 60, and ss < 60, where “ddd” denotes the number of days, “hh” denotes
hours, “mm” denotes minutes, and “ss” denotes seconds.
All the period data must be twelve characters or less (i.e. “ddd:hh:mm:ss”. d, h, m, and s are optional
numeric characters).

The specified measurement period has been set.

You can insert and add rows by either of the following ways:

• Using a shortcut menu that opens by a right-click

• Using keystrokes of CTRL+I and CTRL+R

10. Save the table.
From the “File” menu, choose “Tag/Log Table” then “Save As” to save the table.

-End of procedure-
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3.6 Downloading the setup data to the main unit

If the setup operation for the personal computer has been completed, download the setup
data of the tag, log, and operator name to the main unit.
Tag setup data and log setup data is downloaded in a batch and as one file.  The operator data
is downloaded separately.

NOTE

If the setup data is downloaded to the main unit, the setup data and measurement data
that existed in the main unit before download is deleted.

■ Preparation for downloading

1. Confirm that the power to the personal computer and main unit is OFF.

2. Connect the personal computer and main unit with the supplied cable.

See Also
For how to connect the personal computer and main unit, refer to “■ Connecting the personal com-
puter and main unit” in Section 3.1.

3. Turn on the power of the main unit.

See Also
For how to turn on the power to the main unit, refer to Chapter 4, “Turn ON/OFF of the Power Supply”
in the “Before Use” part.

4. Turn on the power of the personal computer.
Now it is ready for downloading.

-End of procedure-
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■ Downloading the tag and log setup data to the personal computer

1. Initiate Thermo-Collector software.
After the main screen of Thermo-Collector software has been displayed, the “Setup Tags/Logs - New” screen is
displayed.

2. Load a file in which the tag and log setup data is stored.

See Also
For how to load a file containing tag and log data, refer to “■ Loading a file containing the setup data”
in Section 3.2.

3. Select “Send” in the “Setup Tags/Logs” submenu accessed from the “File” menu.
The confirmation dialog box appears.

4. Click on the [OK] button.
A dialog box indicating the progress of data downloading is displayed.  At the same time, “Communicating ...” is
displayed on the main unit.

After the downloading of the tag and log setup data has been completed, the screen indicating the progress of data
downloading and the screen displaying the “Communicating ...” message on the main unit disappears.

-End of procedure-



4444

3  Setting Up with the Personal Computer

IM 54011-E

■ Downloading the measurement operator name data

1. Load a file in which the operator name to be downloaded is stored.

See Also
For how to load a file containing operator names, refer to “■  Loading a file containing the setup data”
in Section 3.2.

2. Select “Send” in the “Setup Persons” menu accessed from the “File” menu.
A dialog box indicating the progress of downloading is displayed.
At the same time, “Communicating ...” is displayed on the main unit.

After the downloading of the operator data has been completed, the screen indicating the progress of data download-
ing and the screen displaying the “Communicating...” message on the main unit disappears.

-End of procedure-
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■ Downloading comment settings

1. Open the comment setting file you want to download.

2. From the File menu, choose Setup Comments then Send.
The dialog box appears and informs you that Thermo-Collector is downloading the settings.  At the same time, the
“Communicating...” message appears on the TM20’s LCD.

- End of procedure -
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4 Setting Up with the Main Unit

4.1 Setups required to use col-
lector function (setting tag
names, alarms, name of
person, and comment, and
selecting input channel(s))

Before using the collector function, the fol-
lowing tag setups must be made.

■ Setup contents

See Also
For information about each setup item, refer to
Section 3.4, “Setups required to use collector
function (settintg tag names, alarms, name of
person, and comment, and selecting input
channel(s))”.

• Tag name
• Input channel
• Alarm
• Operator name
• Comment

■ Creating a new tag
Create new tags for recording the measure-
ment data.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [1], and [3] keys, in
order.
The “Tag Ins” screen appears.

F13

Tag I n s

2. Press the [SET] key.
A screen for selecting the tag name appears.

Burger

0

[TIP]

If no tag has been created in the main unit,
[NewTag] is displayed on the screen.

3. Press the [▼] key repeatedly until
[NewTag] is displayed on the screen.

[NewTag]

0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage changes.

[NewTag]

0

[TIP]

Select “A” and “B” at the two-channel simul-
taneous measurement.

5. Press the [SET] key.
A screen for entering a new tag name appears.

[NewTag]
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[TIP]

If a new tag is created while [NewTag] is dis-
played, the created tag is added to the end of
the list.  If the [SET] key is pressed while
[NewTag] is not displayed, the created tag is
inserted immediately before the selected tag.

6. Enter the tag name.

[NewTag]
Convey

[TIP]

A tag name can consist of a maximum of eight
alphanumeric characters.

See Also
For information about entering a character or
number, refer to Chapter 6, “How to Input Char-
acters” in the “ Before Use” part.

7. Press the [SET] key.
A screen asks you to confirm the setting.

Insert?

Yes1/No0

8. Press the [1] key.
A new tag is created.

Convey

0
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

■ Setting the alarm function for
each tag
The alarm function can be set according to
different tag conditions, or the same alarm
function can be set for all tags.
The following procedure is used to set the
alarm function for different conditions.

See Also
To set the same alarm function for all tags, pro-
ceed to “■  Batch-setting the alarm function”.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [7], and [2] keys, in
order.
The “1File” screen appears on the LCD.

F72

1 F i l e

2. Press the [SET] key.
A screen for selecting a tag name appears.

Convey

0

3. Press the [▼] key repeatedly until the
desired tag name number is called up.

4. Press the [SET] key.
A screen for setting the “Hi Alarm” function ON/OFF
appears.

Hi Alarm

ON
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5. Use either the [▼] or [▲] key to set the
upper-limit temperature alarm function
ON/OFF.

6. If ON has been selected, press the [SET]
key.
The “Hi Alarm” setting screen appears.
If OFF has been selected in step 5, this screen will
not appear.  In this case proceed to step 8.

Hi Alarm

0 0 0 0 . 0 ° C

7. Enter the upper-limit temperature.

Hi Alarm

0 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [▼] or
[▲] key.  “0” on the screen will change to a
“-” symbol.

8. Press the [SET] key.
The specified upper-limit temperature is set and the
screen for setting the “Lo Alarm” function ON/OFF
appears.

Lo Alarm

ON

9. Use either the [▼] or [▲] key to set the
lower-limit temperature alarm function
ON/OFF.

10. If “ON” has been selected, press the
[SET] key.
The “Lo Alarm” setting screen appears.
If “OFF” has been selected in step 9, this screen will
not appear.  In this case proceed to step 12.

Lo Alarm

0 0 0 0 . 0 ° C

11. Enter the lower-limit temperature.

Lo Alarm

0 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [▼] or
[▲] key.  “0” on the screen will change to a
“-” symbol.

12.Press the [SET] key.
The specified lower-limit temperature is set and the
“Turn” screen appears.

Turn

OFF

13.Use either the [▼] or [▲] key to select
whether the operation of the alarm func-
tion is to be inverted.  If ON is selected,
the alarm function will operate under the
inverse conditions.

14.Press the [SET] key.
The range in which the alarm sounds is displayed.
Then, the screen asks you to confirm the setting.

Yes1/No0
Change?

15.Press the [1] key.
The alarm function is set for each tag.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-



49
IM 54011-E

4  Setting Up with the Main Unit

4949

P
rep

arin
g

 fo
r

M
easu

rem
en

t

■ Batch-setting the alarm function
The following procedure is used to set the
same alarm function for all tags.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [7], and [1] keys, in
order.
The “All File” screen appears on the LCD.

F71

A l l F i l e

2. Press the [SET] key.
A screen for setting the “Hi Alarm” function ON/OFF
appears.

Hi Alarm

ON

3. Use either the [▼] or [▲] key to set the
upper-limit temperature alarm function
ON/OFF.

4. If ON has been selected, press the [SET]
key.
The “Hi Alarm” setting screen appears.
If OFF has been selected in step 3, this screen will
not appear.  In this case proceed to step 6.

Hi Alarm

0 0 0 0 . 0 ° C

5. Enter the upper-limit temperature.

Hi Alarm

0 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [▼] or
[▲] key.  “0” on the screen will change to a
“-” symbol.

6. Press the [SET] key.
The specified upper-limit temperature is set and the
screen of selecting ON/OFF of the “Lo Alarm” func-
tion appears.

Lo Alarm

ON

7. Use either the [▼] or [▲] key to select
ON/OFF of the lower-limit temperature
alarm function.

8. When ON has been selected, press the
[SET] key.
The “Lo Alarm” setting screen appears.

If OFF has been selected in step 7, this screen will
not appear.  In this case proceed to step 10.

Lo Alarm

0 0 0 0 . 0 ° C
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9. Enter the lower-limit temperature.

Lo Alarm

0 0 2 0 . 0 ° C

[TIP]

In order to set a negative value, press either
the [▼] or [▲] key.  “0” on the screen will
change to a “-” symbol.

10.Press the [SET] key.
The specified lower-limit temperature is set and the
“Turn” screen appears.

Turn

OFF

11.Use either the [▼] or [▲] key to select
whether the operation of the alarm func-
tion is to be inverted.  If ON is selected,
the alarm function will operate under the
inverse condition.

12. Press the [SET] key.
The range in which the alarm sounds is displayed.
Then, the screen asks you to confirm the setting.

Change?

Yes1/No0

13.Press the [1] key.
The range in which the alarm function is active is set
for all tags as a batch.

Press the [ESC] key repeatedly to return to the Home
screen.

[TIP]

If another alarm function is batch-set for all
tags after one alarm function has been batch-
set, only the latest one is effective.

-End of procedure-

■ Registering the measurement
operator name

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [8], and [3] keys, in
order.

F83

E n t r y

2. Press the [SET] key.
A screen for registering an operator name appears.

1

S m i t h

3. Press the [▼] key repeatedly until the
desired operator name number is called
up.

2

[TIP]

Up to 10 operators, which are serially num-
bered, can be set in a TM20.

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters” in the
“Before Use” part.
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4. Press the [SET] key.

5. Enter the operator name with a maxi-
mum of eight characters.

2

See Also
For how to enter a character or number, refer
to Chapter 6, “How to Input Characters” in the
“Before Use” part.

6. Press the [SET] key.
The screen for confirming the settings appears.

Entry?

Yes1/No0

7. Press the [1] key.
The specified operator name has been set.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

■ Setting comments

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [0], and [2] keys in
order.

F02

Comment

2. Press the [SET] key.
A screen for setting comments then appears.

1

D i s c a r d

3. Press the [▼] key repeatedly until the
desired comment number is called up.

2

[TIP]

Up to 32 comments, which are serially num-
bered, can be set in a TM20.

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters,” in the
“Before Use” part.

4. Press the [SET] key.

5. Enter a comment of up to 8 characters.

2

6. Press the [SET] key.
The screen asks you to confirm the setting.

Entry?

Yes1/No0

7. Press the [1] key.
The comment is then set.

Press the [ESC] key repeatedly to return to the home
screen.

- End of procedure -
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4.2 Setups required to use the
logging function
(setting the log name, input
channel, measurement in-
terval, and measurement
period)

Before using the logging function, it is nec-
essary to make logs settings.

■ Setup contents
See Also
For more information about each setup item,
refer to Section 3.2, “Setups required to use
the log (Setting the log name, input channel,
measurment interval, and measurement pe-
riod)”

• Log name
• Input channel
• Measurement Interval
• Measurement period

■ Operation procedure

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [2], and [3] keys, in
order.
The “Log Ins” screen appears on the LCD.

F23

Log Ins

2. Press the [SET] key.
A screen for selecting the log name appears.

Accept1

0

[TIP]

If no log has been created in the main unit,
[NewLog] is displayed on the screen.

3. Press the [▼] key repeatedly until
[NewLog] appears on the screen.

[NewLog]

0

4. Use the [CH] key to select the input
channel.
The channel indication below “INPUT” changes ac-
cordingly.

[NewLog]

0

[TIP]

Select “A” and “B” at the two-channel simul-
taneous measurement.

5. Press the [SET] key.
A screen for entering a new log name appears.

[NewLog]

[TIP]

If a new log is created while [NewLog] is dis-
played, the created log is added to the end of
the list.  If the [SET] key is pressed while
[NewLog] is not displayed, the created log is
inserted immediately before the selected log.

6. Enter the log name.

Accept2

[NewLog]
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[TIP]

A log name can consist of a maximum of eight
alphanumeric characters.

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters” in the
“Before Use” part.

7. Press the [SET] key.
A screen for setting the measurement interval appears.

Interval

0 0 : 0 0 : 1 0

8. Enter the hour, minute, and seconds.

Interval

0 1 : 1 5 : 3 0

[TIP]

• Set “2 seconds” or more as measurement
interval at the two-channel simultaneous
measurement.

• The definition and range of each input value
is given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 24 hours.

9. Press the [SET] key.
The specified measurement interval is set and the
screen for setting the measurement period (select the
number of days from the options, which also includes
the number of hours, minutes, and seconds) is dis-
played.

ProdDay

002

10. Enter the number of days.

11. Press the [SET] key.
The screen for setting the measurement period (select the
number of hours, minutes and seconds from the options,
which also includes the number of days) is displayed.

ProdTime

0 0 : 0 0 : 0 0
12. Enter the number of hours, minutes, and

seconds.

ProdTime

0 1 : 3 0 : 0 0
[TIP]

The definition and range of each input value
are given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 23 hours.



54
IM 54011-E

5454

4  Setting Up with the Main Unit

13. Press the [SET] key.
The screen for confirming the settings appears.

Insert?

Yes1/No0
14. Press the [1] key.

The specified measurement period has been set.

Accept2

0
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.1 Confirming the number of
pieces of tag data

This section explains the procedure for con-
firming the number of pieces of tag data.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [1], and [1] keys, in
order.
The “Curr Tag” screen appears on the LCD.

F11

Curr Tag

2. Press the [SET] key.

Burger

12

3. Press the [▼] key repeatedly until the tag to
be confirmed is displayed on the screen.
The tag name and the measurement data recorded in
association with the tag is displayed.

Beef

5
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.2 Modifying the tag name

This section explains the procedure for modi-
fying the tag name.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [1], and [2] keys, in
order.
The “TagChnge” screen appears on the LCD.

F12

TagChnge

2. Press the [SET] key.

Burger

12

3. Press the [▼] key repeatedly until the
tag to be modified is displayed on the
screen.

Beef

5

4. Use the [CH] key to select the input
channel.
The channel indication below “INPUT” changes ac-
cordingly.
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5. Press the [SET] key.

Beef

5

6. Enter a new tag name to be modified.

Pork

5

[TIP]

A tag name that has not been modified is dis-
played.  If it needs to be modified, overwrite it
with a new tag name.

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters” in the
“Before Use” part.

7. Press the [SET] key.
The confirmation dialog box appears.

Change?

Yes1/No0

8. Press the [1] key.
The tag name after modification is displayed.

Pork

5
The tag name has been modified.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.3 Clearing the measurement
data associated with the tag

This section explains the procedure used to
clear the measurement data obtained with the
collector function.  However, the setup data
(tag name) will not be cleared.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [4], and [1] keys, in
order.
The “1TagFile” screen appears on the LCD.

F41

1 Ta g F i l e
2. Press the [SET] key.

Burger

12
3. Press the [▼] key repeatedly until a tag

with measurement data that is to be
cleared is displayed on the screen.

Chicken

27
4. Press the [SET] key.

The confirmation dialog box appears.

TagClr?

Yes1/No0
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5. Press the [1] key.

Chicken

0
All the measurement data of the selected tag is
cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.4 Deleting the tag

This section explains the procedure used to
delete the tag from the main unit.

Note

Before deleting the tag, save the mea-
surement data associated with the tag
to a personal computer, etc.
Once the tag has been deleted, all the
measurement data associated with the
tag is completely lost.

See Also
For how to save the measurement data, refer to
Chapter 1, “Receiving the Data on the Personal
Computer” in the “Working with Measurement
Data” part.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [1], and [4] keys, in
order.
The “Tag Del” screen appears on the LCD.

F14

Tag Del

2. Press the [SET] key.

Burger

12

3. Press the [▼] key repeatedly until the
tag to be deleted is displayed on the
screen.

Chicken

0

4. Press the [SET] key.
The confirmation dialog box appears.

Delete?

Yes1/No0

5. Press the [1] key.
The selected tag and its associated measurement data
is deleted.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.5 Confirming the log setup
data

This section explains the procedure used to
confirm the log setup data.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [2], and [1] keys, in
order.
The “Curr Log” screen appears on the LCD.

F21

Curr Log

2. Press the [SET] key.

Convey

12

3. Press the [▼] key repeatedly until the
log to be confirmed is displayed on the
screen.

Accept

0

4. Press the [SET] key.
The current interval is displayed.

Interval

0 0 : 0 0 : 1 0

5. Press the [SET] key.
The current period (the number of days selected from
the options, including also the number of hours, min-
utes, and seconds) is displayed.

ProdDay

2

6. Press the [SET] key.
The current period (the number of hours, minutes,
and seconds from the options including also the num-
ber of days) is displayed.

ProdTime

0 0 : 0 0 : 3 0

[TIP]

If the [SET] key is pressed, the screen used to
confirm the interval set in step 4 is restored.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.6 Modifying the log name
and setup data (measure-
ment interval and period)

This section explains the procedure used to
modify the log name, measurement interval,
and measurement period.

Home screen

18:54:27

22225.9°C
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1. Press the [FUNC], [2], and [2] keys, in
order.
The “LogChnge” screen appears on the LCD.

F22

LogChnge

2. Press the [SET] key.
A screen for selecting a log is displayed.

Convey

12

3. Press the [▼] key repeatedly until the
log to be modified is displayed on the
screen.

Accept

0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage is modified.

5. Press the [SET] key.
A screen for modifying the log name is displayed.

Accept

0

6. Enter a new log name to be modified.

Carry

0

[TIP]

• A log name can consist of a maximum of
eight alphanumeric characters.

• A tag name that has not been modified is
displayed on the screen.  If it needs to be
modified, overwrite it with a new tag name.

See Also
For how to enter letters and numbers, refer to
Chapter 6, “How to Input Characters” in the
“Before Use” part.

7. Press the [SET] key.
A screen for modifying the measurement interval
appears.

Interval

0 0 : 0 0 : 1 0

8. Enter the hours, minutes, and seconds.

Interval

0 0 : 0 0 : 3 0

[TIP]

The definition and range of each input value is
given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 24 hours.
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9. Press the [SET] key.
The measurement interval is modified and a screen for
modifying the measurement period (the number of days
from the options, which also includes the number of
hours, minutes, and seconds) is displayed.

ProdDay

000
10. Enter the number of days.

[TIP]

Between 0 and 999 days can be inputted.

11. Press the [SET] key.
A screen for modifying the measurement period (the
number of hours, minutes, and seconds from the op-
tions, which also includes the number of days) is dis-
played.

ProdTime

0 0 : 0 0 : 3 0
12. Enter the number of hours, minutes, and

seconds.

ProdTime

0 0 : 0 0 : 4 5

[TIP]

The definition and range of each input value is
given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 23 hours.

13. Press the [SET] key.
The confirmation dialog box appears.

Change?

Yes1/No0

14. Press the [1] key.
The measurement period has been set.

Carry

0
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.7 Clearing the measurement
data associated with the log

This section explains the procedure for clear-
ing the measurement data obtained with the
logging function.  However, the setup data
(log name, measurement interval, and mea-
surement period) will not be cleared.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [4], and [2] keys, in
order.
The “1LogFile” screen appears on the LCD.

F42

1 L o g F i l e

2. Press the [SET] key.

Convey

12

3. Press the [▼] key repeatedly until a log
with measurement data that is to be
cleared is displayed on the screen.

Accept

3

4. Press the [SET] key.
The confirmation dialog box appears.

LogClr?

Yes1/No0

5. Press the [1] key.

Accept

0
All the measurement data of the selected log is
cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.8 Deleting the log

This section explains the procedure used to
delete the log from the main unit.

Note

Before deleting the log, save the mea-
surement data associated with the log
to a personal computer, etc.
If the log has already been deleted, all
the measurement data associated with
the log is completely lost.

See Also
For how to save the measurement data, refer to
Chapter 1, “Receiving the Data on the Personal
Computer” in the “Working with Measurement
Data” part.

Home screen

18:54:27

22225.9°C
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1. Press the [FUNC], [2], and [4] keys, in
order.
The “Log Del” screen appears on the LCD.

F24

Log Del

2. Press the [SET] key.

Convey

12

3. Press the [▼] key repeatedly until the
log to be deleted is displayed on the
screen.

Accept

0

4. Press the [SET] key.
The confirmation dialog box appears.

Delete?

Yes1/No0

5. Press the [1] key.
The selected log and its associated measurement data
is deleted.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.9 Batch-clearing the mea-
surement data associated
with both the tag and log

This section explains the procedure used to
clear all the measurement data associated
with both the tag and log.  However, note
that the setup data will not be cleared.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [4], and [4] keys, in
order.
The “All File” screen appears on the LCD.

F44

A l l F i l e

2. Press the [SET] key.

DataClr?

Yes1/No0

3. Press the [1] key.
All the measurement data recorded in the main unit
is cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.10 Initializing the main unit

This section explains the procedure used to
initialize the main unit.

Note

Before initializing the main unit, it is rec-
ommended to save the setup data and
measurement data in the main unit to a
personal computer, etc.
When the main unit is initialized, all the
setup data and measurement data re-
corded in the main unit is lost.  However,
the instrument name, chime setup, and
time setup data will not be erased.

See Also
For how to save the measurement data, refer to
Chapter 1, “Receiving the Data on the Personal
Computer” in the “Working with Measurement
Data” part.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [0], and [1] keys, in
order.
The “Initial” screen appears on the LCD.

F01

I n i t i a l

2. Press the [SET] key.

I n i t i a l ?

Yes1/No0

3. Press the [1] key.
The initialization process begins.

I n i t i a · ·

In two minutes, all the data set in the main unit is erased
and the “Initial” screen is restored,
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.11 Confirming the current op-
erator name

This section explains the procedure used to
confirm the operator name currently set.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [8], and [1] keys, in
order.
The “CurrData” screen appears on the LCD.

F81

Cur rDa ta

2. Press the [SET] key.
The operator name currently set is displayed.

1

S m i t h
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.12 Modifying the operator

This section explains the procedure used to
switch the currently set operator.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [8], and [2] keys, in
order.
The “Change” screen appears on the LCD.

F82

Change

2. Press the [SET] key.
A screen for modifying the operator is displayed.

1

S m i t h

3. Press the [▼] key repeatedly until the
operator to be modified is displayed on
the screen.
Operator names assigned to numbers between 1 and
10 is sequentially displayed.

2

W h i t e

4. Press the [SET] key.
The operator set on the main unit is changed.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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When measuring temperatures with Thermo-Collector, it is necessary to use an
appropriate input channel and probe.  By combining these items in different ways,
it is possible to measure the temperature of various objects.  The temperature of
the surface and center of a solid, and various types of liquids can be measured.
Thermocouple (Type K, J, E, T) or Output voltage (±100mV/±1V) can be plugged
into channels A and B.
The measured values of channels A and B can be recorded simultaneously.

Input channel A, B Thermocouple Type: K

Type Model
Standard sheathed probe for liquid 90020

Fast-response sheathed probe for liquid 90021

Long sheathed probe for liquid 90022

Fast-response injection-needle sheathed probe 90023

Standard injection-needle sheathed probe 90024

Standard surface-temperature straight probe 90030

Standard surface-temperature angle probe 90031

High-surface-temperature straight probe 90032

High-surface-temperature angle probe 90033

Bead TC 245907

Warning

Do not point the tip of a needle-type thermo probe towards somebody.  The needle tip
is very sharp and can cause injury.

Caution

• Handle the needle-type thermo probe carefully so that its stylus is only put into the
intended measuring object.

• Do not use this instrument in a location where it may be splashed or dropped in
water, otherwise it may malfunction.

1 Input Channel and Probe

1 Input Channel and Probe
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ESC FUNC

CH

MEMORY

CLEAR

SET

LOGGING POWER

WXYZ

Symbol

YUVPQRS

GHI

ABC DEF

JKL MNO

Thermo probe

An example of the thermo probe connected to input channel “A”

[TIP]

To plug a voltage output sensor into channel A or B, use a U-shaped omega connector.

xxxxxx
xxxxxxxxxxxx

POINTER MEASURE

ESC FUNC

CH

MEMORY

CLEAR

SET

LOGGING POWER

WXYZ

Symbol

YUVPQRS

GHI

ABC DEF

JKL MNO

Non-contact thermo probe
Model: 90003 (obsolete product)

An example of the non-contact thermo probe connected to input channel “D”

1 Input Channel and Probe
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2 Measuring Temperatures with the Collector Function

This section explains the procedure for measuring temperatures with the collector function.

NOTE

Condensation may occur if the instru-
ment is moved to another place where
both ambient temperature and humid-
ity are higher / lower, or if the room tem-
perature changes rapidly.  In such
cases, acclimatize the instrument to the
new environment for at least 30 minutes
before starting operation.

Home screen

18:54:27

2 5 . 9 ° C
[TIP]

• This screen which indicates the current time
is referred to as the “Home” screen.  Each
function in the main unit is accessed from
this screen.

• The [0] key is also used for switching the
unit of temperature display.  If, for example,
this [0] key is pressed in the Home screen,
the unit is switched to “°F”. Another press-
ing of the same key will restore the unit to
“°C”.

1. Press the [LOGGING] key when the LOG
mark is displayed in the upper left cor-
ner of the screen.

The  LOG  mark is turned off and the
collector mode is entered.

2. Connect the probe to the appropriate
input channel jack.

See Also
For how to connect an input channel to a probe,
refer to Chapter 1, “Input Channel and Probe”.

3. Press the [▼] key repeatedly until the
tag to be selected is displayed on the
screen.
The tag name currently set is displayed.

Burger

24°C
4. If the operator name needs to be modi-

fied, press the [1] numeric key.  If not,
proceed to step 7.

[TIP]

If the operator name is not modified at this point,
the operator name assigned the registration number
“1” will automatically be set. Therefore, the factory-
setting operator name must be modified if an op-
erator other than that which is assigned the registra-
tion number “1” performs the measurement task.

1

S m i t h
A screen for modifying the operator name is dis-
played.

5. Press the [▼] key repeatedly until the
operator name to be selected is dis-
played on the screen.

2

W h i t e

2 Measuring Temperatures with the Collector Function
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6. Press the [SET] key.
The confirmation screen appears.

Change?

Yes1/No0

7. Press the [1] key.
The operator name is modified and the previous
screen displaying the tag name is restored.

Burger

24°C

8. Press the [MEMORY] key.
A  mark is displayed in the measurement screen,
and the measurement is terminated as soon as the
buzzer sounds.  The measured value is stored in
memory together with the current time.

Burger

24°C
The   mark is turned off after the measurement
has been completed.

[TIP]

• If the [MEMORY] key is pressed when
[NewTag] is being displayed, a new tag will
automatically be created.  New tags will
automatically be assigned tag names such
as TAG01 and TAG02.

• If the measurement continues with the se-
lected tag, perform step 7 again after step 8
has been performed.  With 50 tags, a total
of 5,000 pieces of data can be recorded.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

2 Measuring Temperatures with the Collector Function

The procedure below shows the way to
memorize the comments.

1. Press the [▲] or [▼] key to display the
screen “Tag name”.

Burger

57°C

2. Press the [4] key.
The comment which are memorized appears.

1

D i s c a r d

3. Press the [▲], [▼] key to select the com-
ment.

4. Press the [SET] key.

Memory?

Yes1/No0

5. Press the [1] key.
The comment is stored in memory, then the screen
displaying the tag name is restored.

-End of procedure-
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3 Measuring Temperatures with the Logging Function

If a log has measured data remaining in it, it is not possible to record new mea-
surement data additionally on the same log.  To record new data in the log, it must
be cleared beforehand.

Note

Condensation may occur if the instru-
ment is moved to another place where
both ambient temperature and humid-
ity are higher / lower, or if the room tem-
perature changes rapidly.  In such
cases, acclimatize the instrument to the
new environment for at least 30 minutes
before starting operation.

See Also
For how to clear the measured data in a log,
refer to Section 5.7, “Clearing the measurement
data associated with the log” in the “Preparing
for Measurement” part.

Home screen

18:54:27

25.9°C

1. Press the [LOGGING] key when the  LOG
mark is not displayed in the upper left
corner of the screen.
The  LOG  mark is turned on and the logging mode
is entered.

18:54:42

25.9°C

2. Connect the probe to the appropriate
input channel jack.

See Also
For how to connect an input channel and a
probe, refer to Chapter 1, “Input Channel and
Probe”.

3. Press the [▼] key repeatedly until the
log to be selected is displayed on the
screen.
The log name currently set is displayed.

Carry

24°C

4. Press the [MEMORY] key.
The interval at which the temperature measurement
is performed is displayed.

Interval

0 0 : 0 0 : 1 0

5. Press the [MEMORY] key again.
Measurement begins.  During measurement the 
mark is displayed in the lower left corner of the
screen.

00:00:07

24°C

[TIP]

• During measurement the number of days or
time elapsed can be confirmed with the [▲]
key or [▼] key.

• If the [MEMORY] key is pressed when
[New Log] is being displayed, a new tag will
automatically be created.  New tags will
automatically be assigned tag names such
as TAG01 and TAG02.

• To stop the measurement, hold down the
[ESC] key for about two seconds.

3 Measuring Temperatures with the Logging Function
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If the measurement has been completed, the previ-
ous screen displaying the log name is restored.

Carry

24°C
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

3 Measuring Temperatures with the Logging Function
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4 Measuring Temperatures of Channels A and B Simultaneously

■  Selecting input channels
Using the [CH] key to select two channels.

The channel indications below “INPUT” changes ac-
cordingly.

Burger

56.7°C

[TIP]

When data recorded by single-channel mea-
surements remains in the selected tag or log,
you cannot choose channels A and B at the same
time.  Or when data recorded by two-channel
measurements remains in the selected tag or
log, you cannot choose channel A, B, or D.
Delete the recorded data in either case.

For a selected tag or log, the measured values of channels A and B can be re-
corded simultaneously.  However, if data recorded by single-channel measure-
ments remains in the selected tag or log, simultaneous two-channel recording
cannot be started.  In this case, first delete the data from the record.

See Also
• For how to delete measured data, refer to

the following sections in the “Before Use”
part:

- Section 5.3, “Clearing the measurement
data associated with the tag”

- Section 5.7, “Clearing the measurement
data associated with the log”

• For basic operations of temperature mea-
surements, refer to the following chapters
in the “Measuring Temperatures” part:

- Chapter 2, “Measuring Temperatures
with the Collector Function”

- Chapter 3, “Measuring Temperatures
with the Logging Function”

■ Plugging in probes
Plug probe cables into input channels A and
B.

 Note

Use a non-grounded probe for either
channel.  If there is no choice other than
to use grounded probes for both chan-
nels, ensure that the potential difference
between the channels A and B will not
exceed ±1 V.  Nevertheless, when per-
forming real-time upload of measured
values, non-grounded probes must be
used for both channels.

4 Measuring Temperatures of Channels A and B Simultaneously
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■  Recording measured values

1. Press the [MEMORY] key to start record-
ing the measured values.
The current measured value is then displayed.

2. Press the [SET] key to call up a screen
for two-channel measurements.

← Measured value 
of channel A

← Measured value 
of channel B

Burger

56.7°C

Pressing [SET]

A-B

11.6°C

Indication of 
temperature 
difference

Pressing [SET]

AVG

50.9°C

Indication of 
temperature 
average

[TIP]

To return to the original screen, press [ESC].

4 Measuring Temperatures of Channels A and B Simultaneously
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The measurement accuracy of the non-contact thermo probe(Model:90003;
Obsolete product) is not reliable below the decimal point.  Therefore, before mak-
ing a temperature measurement with the non-contact thermo probe, set this in-
strument so that it does not display a fraction of a temperature in the screen of
the main unit.  The non-contact thermo probe, however, can be used with this
instrument to measure temperatures without performing the following setups, but,
if this is done, the accuracy of the decimal in the temperature measurement can-
not be guaranteed.

■ Switching on/off the decimal
portion of the temperature display

Home screen

18:54:27

2 5 . 0 ° C

1. Press the [FUNC], [9], and [3] keys, in
order.
The “Digit” screen appears on the LCD.

F93

D i g i t

2. Press the [SET] key.
A screen for switching on/off the decimal portion of
the temperature display is displayed.

Digit

0 . 1 ° C

3. Press the [▼] key.
The decimal portion of the display is turned off.

Digit

1°C

[TIP]

Each time the [▼] key is pressed, the decimal
portion of the temperature is toggled on/off.

4. Press the [SET] key.
The decimal portion of the temperature is no longer
displayed.

F93

D i g i t

5. Press the [ESC] key three times.
The time display screen (i.e. Home screen) is restored.

18:54:57

25°C

-End of procedure-

5 Measuring Temperatures with the Non-Contact Thermo Probe

5 Measuring Temperatures with the Non-Contact Thermo Probe
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■ Measuring with the non-contact thermo probe

Warning

Do not look into the laser beam which is emitted from the non-contact thermo probe.
The laser can cause eye damage and other injuries.

Note

Before using the non-contact thermo probe, read the instruction manual supplied with
the non-contact thermo probe.

1. Connect the “D” channel jack on the main unit and the non-contact thermo probe.

[TIP]

• Insert the connector plug so that the “←” mark on the cable grip faces upward.

• The “D” channel jack is located on the left side of the main unit bottom face.

 Measuring in the collector mode

2. Set the main unit to the collector mode, then select a tag and operator name for the
measurement.

See Also
For the collector mode, refer to Chapter 2, “Measuring Temperatures with the Collector Function”.

3. Turn the non-contact thermo probe towards the measuring object, and press the [MEA-
SURE] key.
A laser beam is emitted from the non-contact thermo probe and onto the measuring object.

[TIP]

If the laser beam is not being emitted, press the [POINTER] key on the non-contact thermo probe.

4. While holding down the [MEASURE] key, press the [MEMORY] key on the main unit.
The temperature being displayed on the non-contact thermo probe screen will also be displayed on the screen of the
main unit.  When the buzzer sounds on the main unit, the measured value and current time is stored in memory.

[TIP]

If the measurement continues with the selected tag, perform step 3 again after step 4 has been per-
formed.

-End of procedure-

5 Measuring Temperatures with the Non-Contact Thermo Probe
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 Measuring in the logging mode

2. Set the main unit to the logging mode, then select a log for the measurement.

See Also
For the logging mode, refer to Chapter 3, “Measuring Temperatures with the Logging  Function”.

3. While holding down the [MEASURE] key, turn the non-contact thermo probe towards
the measuring object.
A laser beam is emitted from the non-contact thermo probe and onto the measuring object.

[TIP]

If the laser beam is not being emitted, press the [POINTER] key of the non-contact thermo probe.

4. Press the [MEMORY] key twice.
Measurement begins.

[TIP]

To stop the measurement, hold down the [ESC] key for about two seconds.

After the specified measurement period elapses, the previous screen displaying the log name is restored.

5. Hold down the [MEASURE] key on the non-contact thermo probe until the measure-
ment has been completed.

-End of procedure-

5 Measuring Temperatures with the Non-Contact Thermo Probe
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6 Changing Measuring Range

The TM20 can display and record voltages from a sensor that can output a voltage
signal of ±100 mV or ±1 V (provided that a U-shaped connector is used and the
connector and the temperature input jacks are stabilized at the same tempera-
ture).

6.1 Available ranges

A measuring range can be chosen from ther-
mocouple types K, J, E, and T, and 1 V and
100 mV.

Channel Sensor Unit

A External sensor 1 °C (thermocouple
input)

** (voltage input)
B External sensor 2 °C (thermocouple

input)
** (voltage input)

D Non-contact °C
thermo probe

See Also
For the unit of voltage input represented by the
asterisks, see Section 6.3, “Scaling a voltage
input range.”

6.2 Changing a range

Follow the procedure below to change a
measuring range.

Home screen

18:54:25

2 5 . 9 ° C

1. Press the [FUNC], [9], and [9] keys in
order.
“RangSet” is displayed on the screen.

F99

R a n g S e t

2. Press the [SET] key.
The screen changes to allow for channel selection.

3. Using the [▼] and [▲] keys, call up the
channel for which you want to change
the range.

Channel

C h A

4. Press the [SET] key.
The screen changes to allow you to change the range
of the selected channel.

5. Using the [▼] and [▲] keys, call up the
desired range.
The displayed range changes from K, J, E, T, 1V, and
then 100mV in order.

Range

1 V

6. Press the [SET] key.
If you select K, J, E, or T, the screen changes to the
one shown in step 8.  Or if you select 1V or 100mV,
it changes to the one shown in the next step.

7. The name of the scaling setting and unit
set using Thermo-Collector (PC soft-
ware) are then displayed.
These settings cannot be made or modified via the
TM20 itself.

Lux

1 x
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8. Press the [SET] key.
The screen asks you for confirmation.

Change?

Yes1/No0

9. Press the [1] key.
The setting is changed as you made and the menu
screen returns.

To cancel the change, press [0] in place of [1].  The
menu screen returns.

-End of procedure-

6 Changing Measuring Range
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6.3 Scaling a voltage input range

The scaling settings for voltage inputs from channels A and B can be made using Thermo-
Collector (PC software).

■  What scaling is
The value Y converted from the input voltage level X according to the following equation is
displayed:

Y = aX + b.
Scaling setting means to set gain a and bias b.
For example, if you want to display:

• “0” when the input level is 0 V
• “200” when the input level is 1 V

then the gain and bias should be set as
• a = 200
• b = 0.
The resulting equation is

Y = 200X.
When X is 0, Y is 0.  When X is 1, Y is 200.

■  Setting procedure

See Also
For how to start Thermo-Collector on the PC, refer to Chapter 3, “Setting Up with the Personal Com-
puter” in the “Preparing for Measurement” part.

1. From the File menu, choose Voltage Range Settings to open the Voltage Range Set-
tings dialog box.

[TIP]

The following shows the default settings.

Range Name Unit Gain a Bias b
1V 1V V 1.0 0

100mV 100mV mV 1.0 0

6 Changing Measuring Range

Input from sensor 1V

200

0
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2. Select the voltage range from 1V or 100mV.

3. Double-click the Name box.
Type the name up to 8 alphanumeric characters long.

In the respective boxes below, type the unit  (up to 2 characters), gain (6 digits), and bias (6 digits).  Only alphabeti-
cal letters, percent signs, and spaces are allowed for the unit.

4. From the File menu, choose Voltage Range Settings then Send to download the set-
tings to the TM20 connected.

-End of procedure-

6 Changing Measuring Range
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7 Other Useful Functions

■ To instantly confirm or clear the measured data on the main unit
There is a function on the main unit to clear the recorded measurement data.
If the measured data recorded in the main unit is not required anymore or if it needs to be
cleared instantly, use this function.

1. Bring up the Home screen.

2. Press the [▼] key repeatedly until the tag to be deleted is displayed.

3. Use either the [<] or [>] key to select the measured data to be deleted.

[TIP]

Press the [<] key once to bring the last piece of measured data recorded for the tag up on the screen.

The measured data is displayed.

4. Press the [FUNC] key.
The confirmation screen appears.

5. Press the [1] key.
The measured data is cleared.

[TIP]

If the [FUNC] key is pressed while the tag name display screen is active, all the data associated with
the currently selected tag is cleared (this function can also be applied to logs).

-End of procedure-

■ To start a measurement in the logging mode at a specified time
(timer function)
The main unit has a function (timer function) to start logging measurement at a specified
time.  This is useful to, for example, start logging measurements after one hour.

[TIP]

If the selected log has measurement data remaining in it, this timer function cannot be used.  If this is
the case, either clear the measured data from the log or select another log.

See Also
For how to clear the measured data in a log, refer to Section 5.7, “Clearing the measurement data
associated with the log” in the “Preparing for Measurement” part.

1. Bring up the Home screen.

2. Press the [FUNC], [2], and [5] keys, in order.
The “Timer reserve” screen appears.

3. Press the [SET] key.

4. Press the [▼] key repeatedly until the log to record temperatures are displayed.

5. Press the [SET] key.
The measurement interval set for the selected log is displayed.
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6. Press the [SET] key.

[TIP]

It is also possible to modify the measurement interval setting before pressing the [SET] key.

7. Press the [SET] key.
The measurement period (the number of days from the options which also include the number of hours, minutes, and
seconds) is displayed.

[TIP]

It is also possible to modify the number of days setting before pressing the [SET] key.

8. Press the [SET] key.
The measurement period (the number of hours, minutes, and seconds from the options which also includes the
number of days) is displayed.

[TIP]

It is also possible to modify the number of hours, minutes, and seconds settings before pressing the
[SET] key.

9. Set the date (year/month/day) and time when logging starts.

10. Press the [SET] key.
The confirmation screen appears.

11. Press the [1] key.
 The  mark and“Stand by” is displayed in the screen, and the instrument will enter the wait state.  When the time
set in step 9 is reached, the measurement will automatically begin.

21:30:20

Stand by

[TIP]

To cancel the wait state, hold down the [ESC] key for about two seconds.

-End of procedure-

7 Other Useful Functions
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■ To quickly search for a tag or log
The main unit has a function to search for a tag or log using a number as the key.
This function is useful if there are many logs and tags set in the main unit and is faster than
using the [▼] key.

1. Bring up the Home screen.

2. Press the [▼] key.

3. Press the [POWER] key.

4. Enter a two-digit number.

[TIP]

A two-digit number entered is displayed in the “No.” field of Thermo-Collector screen.  It is recom-
mended to make a note of which tag or log corresponds to which number.

5. Press the [SET] key.
The tag (or log) that corresponds to the entered number is displayed on the screen.

-End of procedure-

■ To record measured data if the tag or log has not been set
In addition to the function for creating a tag or log from the Function menu, the main unit has
a useful way to create them during measurement.
This is very useful when, for example, the temperature of a steel plate needs to be measured,
but a tag for that steel plate has not been set beforehand.

1. Bring up the Home screen.

2. Press the [▼] key repeatedly until [NewTag] or [NewLog] appears on the screen.
[NewTag] or [NewLog] appears on the screen.

3. Press the [MEMORY] key.
The temperature is measured.

[TIP]

Tags (or logs) is temporally assigned a specific name using sequential numbers (Examples: Tag01,
Tag02, Log01, Log02....).  In this case, the measurement interval for the log is automatically set to 10
seconds, and the measurement period of the log is set to 2 days.  However, these temporary tag names
and log names can be modified later as required.

See Also
For how to modify tag or log names, refer to Chapter 5, “Confirm, Modify, Clear, or Delete the Data
with the Main Unit” in the “Preparing for Measurement” part.

-End of procedure-

7 Other Useful Functions
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■ To record the start time and finish time of an operation (only with the
collector function)
The main unit has a function to record the start time and finish time of measurement opera-
tion.
This is useful when, for example, creating a daily report, since the start time and finish time
can be included in Microsoft Excel files or printouts.

● Recording the start time

1. Press the [▼] key repeatedly until the tag to record temperatures is displayed.

2. Press the [2] key.
The confirmation screen appears.

3. Press the [1] key.
The start time is recorded.

-End of procedure-

● Recording the finish time

1. Press the [3] key if selecting a tag.
The confirmation screen appears.

2. Press the [1] key.
The finish time is recorded.

-End of procedure-

■ To restrict inputs from the panel keys (the key lock function)
The main unit has a function called the key lock function that disables all the panel keys for input.
This function is used if the main unit is used only for temperature measurement and a temperature
record does not need to be retained, or when the main unit is used as a clock.
This function can be set by pressing the [FUNC], [9], and [5] keys in order and in the Home screen.
While this function is active, the “Key” mark is displayed in the upper right corner of the screen.

[TIP]

In order to cancel this function, hold down the [ESC] key for about two seconds.

7 Other Useful Functions



8484
IM 54011-E

7 Other Useful Functions

■ To enable only the panel keys (yellow keys) requied for mesurement
(FUNC lock function)
The main unit has a function called the FUNC lock function that enables only the panel keys
required for measurement.  The keys used with this function are given below :
• [MEMORY]
• [▼] and [▲]
• [CH]
• [LOGGING]
• [POWER]
• [ESC]
• [SET]
• [>], [<], [1], [2], [3], and [0] (only if the collector function is on)
This function can also be used when the setup information on the main unit is not to be
modified due to an operation error.
This function can be set by pressing the [FUNC], [9], and [6] keys, in order when the Home
screen is displayed.
When this function is active, the “Key” mark is displayed in the upper right corner of the
screen.

[TIP]

To cancel this function, hold down the [ESC] key for about two seconds.

■ To automatically turn off the power supply if no operation is performed
in a specified period of time (Auto Power Off function)
The main unit has a function called Auto Power Off to automatically turn off the power if the
main unit is not used in a given period of time (5, 10, 20, or 30 minutes).
This function is useful if you forget to tun off the power.
This function can be set by pressing the [FUNC], [9], and [4] keys, in order when the Home
screen is displayed.
When this function is active, the “AUTO OFF” mark is displayed in the upper right corner of
the screen.

■ To determine how much more data can be recorded
The main unit has a function to display how much more measurement data can be recorded
for the tag or log on the screen.
To activate this function, press the [FUNC], [3], and [1] keys, in order when the Home screen
is displayed.  Press the [SET] key to display the remaining memory capacity.  If the [SET] key
is pressed again, the number of measurement data pieces that can be used with the collector
function, if selected, is displayed.  Furthermore, if the [SET] key is pressed another time, the
number of measurement data pieces that can be used with the logging function, if selected, is
displayed.

■ To see the number of measured data pieces recorded on the tag or log
The main unit has a function to display the number of measured data pieces recorded on the
tag or log.
To activate this function, press the [FUNC], [3], and [3] keys, in order when the Home screen
is displayed.
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■ To see the average of the measured data
The main unit has a function to calculate the average of the measured data recorded on the
tags or logs.  This is useful when pieces of data have been collected and the average is re-
quired.
To activate this function, press the [FUNC], [3], and [2] keys, in order when the Home screen
is displayed.
Also, to obtain the maximum and minimum values, press the [FUNC], [3], and [2] keys, in
order when the Home screen is displayed.

■ To sound a chime at the specified time (the chime function)
The main unit has a function called the chime function to sound a chime at a time specified by the
operator.  This function is similar to an alarm clock.
The chime can be made to sound so as to signal the operator to start temperature measurement.
To activate this function, press the [FUNC], [6], and [2] keys, in order when the Home screen
is displayed.

■ To view the screen in a dark place (the backlight function)
The main unit has a backlight function, which provides a light source so that the operator can
view the screen in a dark place.  To activate this function, press the [FUNC], [9], and [1] keys,
in order when the Home screen is displayed.
The backlight is turned off if no operation is performed on the main unit for about 10 seconds.

■ To turn off the electronically generated sound
The main unit has a function to turn off the key operation sound and the alarm.  Use this
function if the electronically generated sound is disturbing you.
To activate this function, press the [FUNC], [9], and [2] keys, in order when the Home screen
is displayed.

■  To view the comments set
To view a list of the comments set in your TM20, press the [FUNC], [0], and [2] keys in order
when the Home screen is displayed.

7 Other Useful Functions
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■  To correct measured temperatures (using the simplified input
correction function)
For each of channels A and B, you can set input correction suitable for the thermocouple type
that has been selected for the input range.  The correction setting for a channel is applied to all
values measured by that channel.  When the correction is effective, the unit is underlined in
the display, such as “°C.”

1. When the Home screen is displayed, press the [FUNC], [9], and [8] keys in order.
“Adjust” is displayed on the screen.

Press the [CH] key and choose the channel for which you want to set a correction.  (A correction can only be set for
channels A and B.)

2. Press the [SET] key.

3. Select ON and press the [SET] key.
The screen changes to allow for correction setting.

4. Enter the correction value.
The range of the correction value is -20.0°C to +20.0°C in units of one tenth of a degree.

The correction value is always added as a bias to the input value.  For instance, if you set 1.5°C, the measured value
at the input of 100°C is displayed as 101.5°C.

5. Press the [SET] key.
The screen asks you for confirmation.

6. Press the [1] key.
The setting is complete and the menu screen returns.

To cancel the change, press [0] in place of [1].  The menu screen returns in this case, too.

7 Other Useful Functions



8787
IM 54011-E

M
easu

rin
g

Tem
p

eratu
res

■ To transmit measured values to a PC in real-time
Once real-time transmission is switched on when your TM20 has been connected to a per-
sonal computer, pressing the [MEMORY] key immediately starts uploading the measured
data to the computer in real-time.  To receive these values, run an appropriate application at a
computer, such as Hyper Terminal in Accessories of Windows 98.
To switch on real-time transmission in your TM20, follow the procedure below.

1. When the Home screen is displayed, press the [FUNC], [5], and [4] keys in order.

2. Press the [SET] key.

3. Using the [▼] or [▲] key, select ON.

4. Press the [SET] key.
A down-arrow (↓ ) appears in the lower left of the screen.  In this state, starting measurements and pressing the
[MEMORY] key to start recording transmits the measured values to the personal computer in real-time.

 Caution

Since the PC interface is not isolated, be sure to use non-grounded probes when trans-
mitting measured values to a PC in real-time.

7 Other Useful Functions
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1 Receiving the Data on the Personal Computer

This section explains the procedure used to receive data, such as measurement
data with the main unit, on the personal computer.  The following data items can
be received:

● Measured data associated with tags and logs
● Tag and log setup data
● Operator name data

Received tag and log data can be transferred to Microsoft Excel95 or Microsoft
Excel97 (hereinafter referred to as Excel) when the data is received on the per-
sonal computer.

■ Preparation before reception

1. Make sure that the power to the personal computer and main unit is turned off.

2. Connect the personal computer and main unit with the supplied cable.

See Also
For how to connect the personal computer and main unit, refer to “■ Connecting the personal com-
puter and the main unit” in Section 4.1 of the “Preparing for Measurement” part.

3. Turn on the power to the main unit.

See Also
For how to turn on the main unit, refer to “■ Turn the power supply to ON” in Chapter 4 of the “Before
Use” part.

4. Turn on the power to the main unit.
Now it is ready for reception.

-End of procedure-

1  Receiving the Data on the Personal Computer
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■ Receiving the data
1. Initiate Thermo-Collector software.

The main screen of Thermo-Collector software is displayed.

2. Select “Receive” from the “Comm” menu.
A screen for selecting the data to be received is displayed.

3. Select the data to be received.

[TIP]

The following data items can be received

• Measured Datas ........ Measured data obtained with the main unit for tags and logs

• Setup Tags/Logs ....... Tags and logs setup data recorded in the main unit

• Setup Persons ........... Measurement operator data in the main unit

• Setup Comment ........ Comment data in the main unit

1  Receiving the Data on the Personal Computer
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4. If the received data is to be transferred to Excel, double-click on the “Transfer” tab.  If
not, proceed to step 6.
A screen for selecting to which Excel file and in which format the data is transferred is displayed.

5. When there is a need to transfer the received measurement data to Excel, select either
"Transfer to the new file" or "Transfer to the specified file".
If "Transfer to the specified file" is selected, click on the "Browse..." tab and select the
Excel file to which the data is transferred. (It is also permitted to enter the specified file
name.)  Then, it is allowed to select "Sheet Form" for designating the data format by
which the measurement data is transferred to Excel.

6. Click on the [Start] button.
A screen showing the progress of data reception is displayed.  “Communicating ...” is also displayed on the screen of
the main unit.

When data reception has been completed, the received data is displayed on the personal computer as follows.

(Two-channel simultaneous
measurement)

for B channelfor A channel

If “Transfer to Excel” is selected in step 5, Excel will automatically be initiated and the received data is transferred
to Excel.

- End of procedure

1  Receiving the Data on the Personal Computer



9191
IM 54011-E

W
o

rkin
g

 w
ith

 th
e M

easu
red

 D
ata

This chapter explains the procedure to directly output the data from the main unit
to the printer (Model name: 970 10, optional).

2.1 Output preparation

Before starting output to the printer, confirm that the printer is connected to the main unit
and the setup conditions of the printer.

■ Printer-main unit connection
A dedicated cable must be purchased (Model name: 910 10, round DIN 8-pin to D-sub 9-pin
straight cable) to connect the printer and this instrument.
Follow the procedure below to connect the printer and main unit.

1. Turn off the power to the printer.
The power lamp is turned off.

2. Refer to the following figure to connect the printer to the main unit.

D

Bottom of the main unit

Main unit

Printer

Power switch On-line switch

Round DIN 8-pin to D-sub 9-pin straight cable (optional)

Printer serial port (9-pin)

ESC FUNC

CH

MEMORY

SET

LOGGING

CLEAR

POWER

WXYZ

Symbol

YUVPQRS

GHI

ABC DEF

JKL MNO

- End of procedure

2 Outputting Directly from the Main Unit to the Printer

2  Outputting Directly from the Main Unit to the Printer
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■ Confirming the printer setup conditions

1. While holding down the [On-line switch] on the printer, turn on the power to the printer.
The printer setup conditions is outputted to the printer.

2. Make sure that the contents are identical to that shown in the following figure.  If they
are different, correct the setup conditions.

See Also
For how to modify the printer setup, refer to the operation manual supplied with the printer.

[DIP SW setting mode]

Dip SW-1
1 (OFF) : Input = Serial

3 (ON) : Auto Loading = ON
4 (OFF) : Auto LF = OFF
5 (ON) : Setting Command = Enable
6 (OFF) : Printing
7 (ON) :    Density
8 (ON) :    = 100%

2 (ON) : Printing Speed = High

Dip SW-2
1 (OFF) : Printing Columns = 80

3 (ON) : Character Select = Normal
4 (ON) : Zero = Normal
5 (ON) : International
6 (ON) :    Character
7 (ON) :    Set
8 (ON) :    = Japan

2 (ON) : User Font Back-up = ON

Dip SW-3
1 (ON) : Data Length = 8 bits

3 (ON) : Parity Condition = Odd
4 (OFF) : Busy Control = XON/XOFF
5 (OFF) : Baud
6 (ON) :    Rate
7 (ON) :    Select
8 (ON) :    = 9600 bps

2 (ON) : Parity Setting = No

3. Turn off the power to the printer.

- End of procedure

2  Outputting Directly from the Main Unit to the Printer
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2.2 Outputting the measured
data to the printer

[TIP]

Connect the main unit and the printer before
turning on the power to the printer.  If this is
not done, the measured data cannot be output-
ted to the printer.

Home screen

18:54:27

22225.9°C

1. Press the [FUNC], [5] and [2] keys, in
order.
The “1File” screen appears on the LCD.

F52

1 F i l e

2. Press the [SET] key.

Burger

11

3. Press the [▼] key repeatedly until the
tag or log to be outputted is displayed.
The tag name or log name and the number of pieces
of measured data recorded in the tag or log is dis-
played.

Convey

11

[TIP]

If the [▼] key is pressed repeatedly, “NewTag”
appears.  Existing tags is displayed before
“NewTag” appears.  Existing logs are displayed
after “NewTag” appears.

4. Press the [SET] key.
The confirmation screen appears.

Print?

Yes1/No0

5. Press the [1] key.
Printout is performed.

[TIP]

To output all the data recorded on the main unit,
press the [FUNC], [5], and [3] keys, in this or-
der, and then press the [SET] and [1] keys.

Press the [ESC] key repeatedly to return to the Home
screen.

- End of procedure

2  Outputting Directly from the Main Unit to the Printer
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 An output example from the printer

[Line A ] HiAlarm=0080.0 LoAlarm=0060.0

No. Date Temp. Hi

00001
56.0°C
57.5°C
59.8°C
61.2°C
62.0°C
62.0°C
70.0°C
75.0°C
81.0°C

00002
00003
00004
00005
00006
00007
00008
00009
00010

OK
OK
OK
OK
OK
OK
OK
OK
OK

Lo Person

Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith

NG
99/10/08/18:00:00
99/10/08/18:00:11
99/10/08/18:00:25
99/10/08/18:00:35
99/10/08/18:00:45
99/10/08/19:00:00
99/10/08/19:00:11
99/10/08/19:00:26
99/10/08/19:00:34
99/10/08/19:00:47

Start Smith

NG
NG
NG
OK

NG=No Good

OK
OK
OK
OK

Output example (tag)

[Line B  ] Interval=00:00:10

No. Date Temp.

00001 99/10/09/20:00:00
99/10/09/20:00:10
99/10/09/20:00:20
99/10/09/20:00:30
99/10/09/20:00:40
99/10/09/20:00:50
99/10/09/20:01:00
99/10/09/20:01:10
99/10/09/20:01:20
99/10/09/20:01:30

-10.5°C
-10.5°C
-11.0°C
-10.5°C
-10.5°C
-11.0°C
-10.5°C
-10.5°C
-11.0°C
-10.5°C

00002
00003
00004
00005
00006
00007
00008
00009
00010

Output example (log)

2  Outputting Directly from the Main Unit to the Printer
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■ Thermo-Collector specifications

● Features

Measuring ranges
Thermocouple types K, J, E, and T, and ±100 mV and ±1 V

Input channels
2 channels (A and B) or single channel (D)

Potential difference between channels
Must not exceed ±1 V (when the RS-232-C cable is not connected).

Measured temperature ranges and resolutions
For input channels A and B at a TM20 (not at a PC)

Range setting Measured temperature range Resolution

Thermocouple type K –200.0 to 1372.0°C 0.1°C
type J –200.0 to 1000.0°C 0.1°C
type E –200.0 to 700.0°C 0.1°C
type T –200.0 to 400.0°C 0.1°C

Voltage input 100 mV –100.0 to 100.0 mV 0.1 mV
1 V –1.000 to 1.000 V 0.001 V

Channel D — Non-contact thermo probe (Model 900 03)
• Measured temperature range: –20.0 to 400.0°C
• Resolution: 1°C

Accuracy
Input channels A and B:

(under the ambient temperature of 23 ±5°C and relative humidity of 20 — 80%, when the low battery alarm is not
occurring, and excluding the accuracy of reference junction compensation)

Input type Range Accuracy

Thermocouple ≥ –100°C ±(0.1% of reading + 0.3°C)
< –100°C ±(0.1% of reading + 0.6°C)

Reference junction compensation — ±0.4°C (when the temperature at input jacks are stabilized)
Voltage 100 mV or 1 V ±(0.1% of reading + 0.2% of range)

Accuracy (error of reading) of input from non-contact thermo probe (channel D):
The error of reading of the input from a non-contact thermo probe that can be connected to the TM20 (i.e., Model
900 03) is ±1°C excluding the error of the probe itself.  (For the error of the non-contact thermo probe, see the
respective specifications.)

Effects of ambient conditions
Effects of ambient temperature changes on thermocouple inputs (channels A and B):

±(0.01% of reading + 0.03°C)/°C or less
Effects of ambient temperature changes on reference junction compensation:

±0.03°C/°C or less (at ambient temperature of 0 – 50°C)
Effects of ambient temperature changes on voltage inputs (channels A and B):

±(0.01% of reading + 0.02% of range)/°C or less
Effects of humidity changes (at relative humidity of 20 – 80%):

±1 digit or less

Battery life
(when not using the backlight of the LCD)
When using collector function: Approx. 2 days (under continuous 24-hour operation) (when the RS-232-C

cable is not connected.)
Approx. 5 days (8 hours of measurements and 30 minutes of communication
every day)

When using logging function: Approx. 2 days (measurement intervals < 10 seconds) (when the RS-232-C
cable is not connected.)
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Approx. 1 month (measurement intervals = 1 minute) (when the RS-232-C
cable is not connected.)
Approx. 1.5 months (measurement intervals = 10 minutes) (when the RS-232-
C cable is not connected.)

TIP
Approx. 1 day when the RS-232-C cable is connected using collector or logging function.

(The battery life varies greatly with the quality of batteries used and the operating conditions.  Shown here are
references for the case when ANSI AA (IEC LR6) alkaline batteries of the same model as those that come with the
TM20 are used and the when TM20 is used under room temperature.)

● Functions

Measurement mode and interval
Collector mode

While the [LOG] sign is off, measurements will be saved in the internal memory if the [Memory] key is pressed
under a condition where an optional tag is being displayed on the screen.  A tag name must consist of maximum
eight alphanumeric characters.  The maximum number of tags is 50.  Measurement intervals: Minimum 0.5 second
when using only 1 channel; minimum 1 second when using 2 channels.
Person (operator) names: Up to 10 names of up to 8 alphanumeric characters can be set.

Logging mode
While the [LOG] sign is on, measurements will be saved in the internal memory if the [Memory] key is pressed
under a condition where an optional log is being displayed on the screen.  A log name must consist of maximum
eight alphanumeric characters.  The maximum number of logs is 10.  The measurement period depends on the
remaining capacity of the internal memory.  The measurement interval should be greater than 1 second and less
than 24 hours.

Capacity of the internal memory
5000 pieces of data with the collector function solely.  If using only the logging function, the maximum data
capacity is 20000 pieces.
However, the measured data collected either with the collector function or with the logging function can co-exist
in the internal memory.

Display
Semi-transmission type liquid crystal display (LCD)
8 characters x 2 lines dot matrix display section and icon display section

Display light
Two backlight LEDs for the display section.  10 seconds of duration from the moment when any key is operated
(factory setting: OFF).

Clock function
Controls the date (internal data) and time (internal data and display).  The accuracy is within 1 minute per month.

Alarm function
This function can be set to the upper-limit temperature and lower-limit temperature.  In both cases, it can be set so
either the alarm is turned on if the temperature falls within or outside the specified range.

Calculation function
The maximum, minimum, or average within the same tag or log file can be calculated.
The difference between values simultaneously sampled from channels A and B can be displayed.

Key operation sound function
Possible to set on or off of the buzzer sound when the keys are operated (factory setting: ON).

Auto power-off time
Selectable from 5, 10, 20, and 30 minutes, or infinite (factory setting: 5 minutes)

Low battery voltage alarm
A battery symbol turns on if the set LR6 alkaline dry cell almost expires.
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Auto Operation Stop at a low battery voltage
When the set LR6 alkaline dry cell is almost used up, the system power will be automatically turned off after the
“BatteryEmpty” message appears.
Do not leave the used battery being set in the main unit.  This may cause operation errors or battery liquid leakage.

Backup battery
A backup battery backs up the measured data and clock setting when the ANSI AA (IEC LR6) alkaline batteries
are not installed.  The typical life of the backup battery is approximately 6 years under room temperature (23
±5°C).  After the voltage of the backup battery drops, “Backup.B Empty” appears on the LCD whenever the power
is turned on.  This message disappears whichever key is pressed.  This message indicates that backup may no
longer be performed.  Please inquire about backup battery replacement service promptly.

Key lock and FUNC lock
Disables the operation keys and function keys other than the Power key (factory setting: OFF).

Least significant digits of display values
The least significant digit of the display values can be selected from the first decimal (0.1°C) and the least digit of
the integer (1°C).  However, it is fixed for the voltage inputs as the first decimal for the 100-mV range (100.0 mV)
and as the third decimal for the 1-V range (1.000 V).  (The factory setting of the least significant digit of displayed
temperature values is 0.1°C.)

Degree of protection provided by enclosures
Equivalent to IP54 (When using the waterproof cover)

I P 5 4

Splashing (protection for being subjected to splash)
Dust-protected (protection for being subjected to dust)
Protection characteristic symbol (International Protection)

Communication function
RS-232C communication function

• Electrical characteristics ..... Conforms to EIA RS-232C standard
• Baud rate .............................. 1200, 2400, 4800, 9600, 19200 [bps]
• Data length ........................... 7, 8 [bit]
• Parity .................................... Odd parity (odd), Even parity (even), or None (None)
• Stop bit ................................. 1, 2 [bit]
• Flow control ......................... Hardware handshake (RTS, CTS) or no flow control

Connector ............................. Round DIN connector with 8 pins (requires a dedicated cable)

*The underline shows the factory settings.

Control lines

Pin No. Signal line name
1 CTS (Clear to Send)
2 RXD (Received Data)
3 RTS (Request to Send)
4 TXD (Transmitted Data)
5, 6 (N.C.)
7 (SENS)   *Note
8 SG (Signal Grounding)

Note: Pin No.7 senses if the RS-232C Connector is plugged.
This is connected to No.8 pin of the dedicated cable.

Since the RS-232-C interface is not isolated, use non-grounded probes and voltage output sensors when using this
interface.

Digital serial communication function (Note: this is not a USB port)
The digital serial I/O port (D ch) is capable of logging the non-contact thermo probe data.

8

1 2

3 4 5

6 7

Connector pin assignment
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Simplified input corrections
A bias within a range between –20.0°C and 20.0°C can be set for the measured values of a thermocouple input.
The bias is added to (or subtracted from) all values measured by each specified channel.  When the correction is
effective, the unit is underlined in the display, such as “°C.”

Scaling of voltage inputs
Using the PC application (Thermo-Collector) that comes with the TM20, an input value X can be converted to a
display value Y according to the equation [Y = aX + b] and a 2-digit unit of alphabetical letters, percent signs, and
spaces can be set for each channel for which a voltage input range is selected.

● External dimensions
Approx. 151 (H) x 56 (W) x 33 (D) mm (excluding the projecting sections)

● Weight
Approx. 180 g (including 2 ANSI AA (IEC LR6) alkaline batteries as standard)

● Approvable standards
EMC standards

EMI (interference signal) EN55011, EN61326-1 (Class B, Group 1)
EMS (immunity) EN50082-1, EN61326-1

Effect of EMS immunity:
Type K, J, E and T range ±5% of span
1V and 100mV range ±5% of range
 (for electromagnetic field with a radio-frequency of 3V/m, under standard use)

Conditions of EMC:
Use External probe and RS-232 cable (less than 3m)

● Battery (reccommeded)
ANSI AA (IEC LR6) alkaline battery, 1.5V (two)

● Operation and storage enviroment
Operation temperature/humidity range: 0 to 50�C, 20 to 80%RH (no condensation)
Storage temperature/humidity range: -10 to 60�C, 5 to 95%RH (no condensation)
The operation and storage environment must be free from organic solvent or corrosive gases.

● Accessories
Instruction manual (including the descriptions of the application software) 1 copy
ANSI AA (IEC LR6) alkaline battery 2 units
Application software (on 1.44 MByte floppy diskette) 3 diskettes
Dust-proof seal (for sealing the screw holes on the back face of the main unit) 2 pieces
Waterproof cover 1 piece

● Probe (option) specifications

Type (Thermocouple Type: K) Model Measuring ranges Accuracy
Standard sheathed probe for liquid 90020 -50 to 600°C 0.4% or ±1.5°C

Fast-response sheathed probe for liquid 90021 -50 to 600°C 0.4% or ±1.5°C

Long sheathed probe for liquid 90022 -50 to 600°C 0.4% or ±1.5°C

Fast-response injection-needle sheathed probe 90023 -50 to 500°C 0.4% or ±1.5°C

Standard injection-needle sheathed probe 90024 -50 to 500°C 0.4% or ±1.5°C

Standard surface-temperature straight probe 90030 -20 to 250°C 0.75% or ±2.5°C

Standard surface-temperature angle probe 90031 -20 to 250°C 0.75% or ±2.5°C

High-surface-temperature straight probe 90032 -20 to 500°C 0.75% or ±2.5°C

High-surface-temperature angle probe 90033 -20 to 500°C 0.75% or ±2.5°C

Bead TC 245907 -40 to 260°C 0.75% or ±2.5°C



9999
IM 54011-E

■ Operation environment of Thermo-Collector software
CPU : i486DX or higher
OS : Windows95/Windows98/WindowsNT4.0
FDD : 3.5", 1.44 MB-formatted
Required space on the HDD :10 MB or greater
Recommended memory capacity :16 MB or greater
Serial I/O capability :A serial port conforming to RS-232C standard should be available.
Software :Microsoft Excel95, Microsoft Excel97

■ External view and dimensions

D RS232C

NO.

Made in
Japan

Yokogawa  M&C  Corporation

WARNING

Measuring
temperature  ranges

ESC FUNC

CH

MEMORY

CLEAR

SET

LOGGING POWER

WXYZ

Symbol

YUVPQRS

GHI

ABC DEF

JKL MNO

Unit: mm

29

32.5

56

15
1
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■  Using the waterproof cover (Model 93011 coming with TM20)
We recommend using a waterproof cover to enhance water resistance (splash-proof-
ing capability) and to keep the instrument clean.

1. Detach the strap attached to the instrument.

2. Plug the probe (connector) cable into sensor mounting location (A) on the body (and
another to mounting location (B) when using two probes), and then put the cover on
the instrument.

3. Lift the probe cable(s) up to fasten it (them) under the Velcro-secured flap. Make sure
that the flap is tightly fastened so that the cover will remain closed.

4. Fold the upper part of this flap down and secure it with the Velcro [1].

[1]

Caution

• The degree of protection (Dust-protected/Splash-proof) provided by enclosures of
this instrument is equivalent to IP54 when using the waterproof cover.

• Be sure to use a waterproof cover in atmospheres of steam (water vapor) and greasy
fumes (oil), or when water is being used near the TM20, otherwise the instrument
may fail.
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■  Function keys quick reference
MenuMenu No. Submenu No. Submenu Description

Confirming the tag

Tag Set

Curr Tag

TagChnge Modifying the tag name

Tag Ins Inserting a tag

Tag Del Clearing the tag

Log Set

Curr Log Confirming the log

LogChnge Modifying the log name

Log Ins Inserting a log

Log Del Clearing the log

Reserve Timer function

CurrData

Capacity Confirming the remaining memory capacity

Calc Confirming the maximum/minimum/average data

Measure Confirming the number of tag data/log data pieces

1TagFile Clearing the measured data associated with the tag

Data Clr
1LogFile Clearing the measured data associated with the log

1TagData Clearing one piece of measured data associated
with the tag/log

All File

Comm

Comm Set Setting the communication environment

1File Outputting the tag/log data for the printer

All File Outputting all data for the printer

Clock

ClockSet Setting the date and time

ChimeSet Setting the chime function to ON/OFF and the time
at which it is turned on/off.

AlarmSet
All File Batch-setting the alarm function for all tags

1File Setting the alarm function for the specified tags

Others

BkLight

KeySound

Digit

APOff

KeyLock

FuncLock

Name

Initial

Backlight ON/OFF

Key operation sound ON/OFF

Setting the Auto Power Off function

On/Off of the temperature fraction display

Key lock ON/OFF

Setting the instrument name

Initializing the setup data and measured dataInitial

Clearing all measurement data

FUNC lock ON/OFF

1

1

1

1

1

1

1

1

1

1

Setting commentsComment2

2

2

2

2

2

2

2

2

2

3

3

1

2

3

3

3

3

3

RealTime Switching on/off real-time data transmission4

3

4

4

4

4

4

5

5

5

6

6

7

7

Adjust Setting simplified input corrections8

RangeSet Setting measuring ranges9

8

9

0

Staff

CurrData

Change

Entry

Confirming the currently selected operator

Modifying the operator

Registering the operator name
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Yokogawa Meters & Instruments Corporation

International Sales Dept.
Tachihi Bld. No.2, 6-1-3, Sakaecho, Tachikawa-shi,Tokyo 190-8586 Japan
Phone: 81-42-534-1413, Facsimile: 81-42-534-1426
YOKOGAWA CORPORATION OF AMERICA (U.S.A.)
Phone: 1-770-253-7000  Facsimile: 1-770-251-2088
YOKOGAWA EUROPE B. V. (THE NETHERLANDS)
Phone: 31-334-64-1611  Facsimile: 31-334-64-1610
YOKOGAWA ENGINEERING ASIA PTE. LTD. (SINGAPORE)
Phone: 65-6241-9933  Facsimile: 65-6241-2606
YOKOGAWA AMERICA DO SUL S. A. (BRAZIL)
Phone: 55-11-5681-2400  Facsimile: 55-11-5681-1274
YOKOGAWA MEASURING INSTRUMENTS KOREA CORPORATION (KOREA)
Phone: 82-2-551-0660 to -0664  Facsimile: 82-2-551-0665
YOKOGAWA AUSTRALIA PTY. LTD. (AUSTRALIA)
Phone: 61-2-9805-0699  Facsimile: 61-2-9888-1844
YOKOGAWA INDIA LTD. (INDIA)
Phone: 91-80-4158-6000  Facsimile: 91-80-2852-1441
YOKOGAWA SHANGHAI TRADING CO., LTD. (CHINA)
Phone: 86-21-6880-8107  Facsimile: 86-21-6880-4987
YOKOGAWA MIDDLE EAST E. C. (BAHRAIN)
Phone: 973-358100  Facsimile: 973-336100
LTD. YOKOGAWA ELECTRIC (RUSSIAN FEDERATION)
Phone: 7-095-737-7868  Facsimile: 7-095-737-7869


